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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking on an enterprise solution consisting of Avaya IP Office Release 11.0 and
Avaya Session Border Controller for Enterprise Release 7.2.2 to interoperate with Claro SIP
Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Claro SIP Trunking Service provides PSTN access via a SIP Trunk between the enterprise and
Claro’s network as an alternative to legacy analog or ISDN-PRI trunks. This approach
generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunking service between Claro SIP Trunking Service and an Avaya SIP-enabled enterprise
solution.

In the sample configuration, the Avaya SIP-enabled enterprise solution consists of Avaya IP Office
500v2 Release 11.0 (hereafter referred to as IP Office), Avaya Session Border Controller for
Enterprise Release 7.2.2 (hereafter referred to as Avaya SBCE), Avaya Communicator for Windows,
Avaya Communicator for Web, Avaya Equinox for Windows and Avaya Deskphones, including
SIP, H.323, digital, and analog.

The Claro SIP Trunking Service referenced within these Application Notes is designed for business
customers. Customers using this service with the IP Office solution are able to place and receive
PSTN calls via a broadband WAN connection using the SIP protocol. This converged network
solution is an alternative to traditional PSTN trunks such as analog and/or ISDN-PRI trunks. This
approach generally results in lower cost for the enterprise.

The terms “service provider” and “Claro” will be used interchangeable throughout these Application
Notes.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Solution & Interoperability Test
Lab by connecting IP Office and the Avaya SBCE to Claro’s SIP Trunking service via a VPN
connection, across the public internet. The configuration in Figure 1 was used to exercise the
features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products only (private network side). Readers should consult the appropriate Avaya product
documentation for further information regarding security and encryption capabilities supported by
those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is the
responsibility of each individual vendor. Readers should consult the appropriate vendor-supplied
product documentation for more information regarding those products.
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2.1 Interoperability Compliance Testing

To verify SIP Trunk interoperability, the following features and functionalities were exercised
during the compliance testing:

SIP OPTIONS queries and responses.

Incoming calls from the PSTN were routed to the DID numbers assigned by Claro. Incoming
PSTN calls were terminated to the following endpoints: Avaya 96x1 Series IP Deskphones
(H.323), Avaya 1100 Series IP Deskphones (SIP), Avaya Communicator for Windows,
Avaya Communicator for Web, Avaya Equinox for Windows, Avaya 9508 and 1408 Digital
Deskphones, and analog Deskphones.

Outgoing calls to the PSTN were routed via Claro’s network to various PSTN destinations.
Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper Codec negotiation and two way speech-path. (Testing was performed with codecs:
G.711MU, G.711A and G.729A, Claro’s preferred codec order).

No matching codecs.

Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail
messages from PSTN phones).

e Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems).
e Calling number blocking (Privacy).
e Call Hold/Resume (long and short duration).
e Call Forward (unconditional, busy, no answer).
e Blind Call Transfers.
e Consultative Call Transfers.
e Station Conference.
e Mobility twinning of incoming calls to mobile phones.
e Simultaneous active calls.
e Long duration calls (over one hour).
e Proper response/error treatment to all trunks busy.
e Proper response/error treatment when disabling SIP connection.
o T.38 fax.
Note: Remote worker was tested as part of this solution; the configuration necessary to support

remote workers is beyond the scope of these Application Notes and is not discussed in these
Application Notes.

Items not supported or not tested included the following:

e (.711 fax pass-through was not tested.
e The SIP REFER method for call redirection was not tested for reasons noted under
Section 2.2.
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e Inbound toll-free calls, Outbound Toll-Free calls, 911 calls (emergency), “0” calls
(Operator), 0+10 digits calls (Operator Assisted), and 411 calls (Local Directory
Assistance) were not tested.

2.2 Test Results

Interoperability testing with Claro was successfully completed with the following
observations/limitations.

T.38 fax calls requires special configuration — On inbound and outbound T.38 fax calls,
when Avaya IP Office reINVITEs for T.38 it includes the existing audio codec marked as
inactive followed by the T.38 codec marked as active, this was causing the T.38 fax calls to
fail. The fix is to configure the Avaya IP Office SIP Line to use the SIP Line Custom String
SLIC_PREFER_ACTIVE_SDP (refer to Section 5.4.7). The SIP Line Custom String
instructs Avaya IP Office to reverse the order of the SDP entries in the T.38 reINVITE so the
active T.38 codec entry appears first. With this configuration, inbound and outbound T.38
fax calls were successful.

SIP REFER — Calls from the PSTN to IP Office that are re-directed to another PSTN
endpoint by the IP Office user, with REFER enabled in IP Office, did not work properly.
Testing was done with REFER disabled in IP Office, refer to Section 5.4.1.

Caller ID on calls forwarded to the PSTN and to “twinned” mobile phones — On calls
originated from the PSTN to IP Office stations with either call-forward or with the mobility
feature active in the IP Office station to another PSTN number, the caller ID number
displayed at the terminating PSTN station was always of the DID number assigned to the IP
Office station, instead of the originating PSTN number. This issue is caused by IP Office
sending INVITE messages to Claro for calls being forwarded and for twinned calls to mobile
stations with the DID number assigned to the IP Office station in the “From” header instead
of sending the PSTN number that originated the call. This issue is under investigation by
Avaya.

Outbound Calling Party Number block (calls with privacy enabled) — The Calling Party
Number is not blocked on calls from IP Office to the PSTN with privacy enabled at the IP
Office station (Withhold Number enabled). This issue is caused by IP Office not including
the privacy header (privacy = id) in the INVITE message sent to Claro. A Signaling
Manipulation script (SigMa) was created in the Avaya SBCE to add “Privacy = id” to the
INVITE messages on calls with privacy enabled in the IP Office stations (Sections 6.3.3 and
11). This issue is under investigation by Avaya.

Conference on Avaya Equinox soft-client — Conference on the Avaya Equinox for
Windows soft-client is not working properly. When the attempt is made to conference active
calls in the Avaya Equinox for Windows soft-client by “merging” the calls together, the
parties are not joined together into conference, instead a new call is made from the first
active call that was held by the Equinox soft-client to the second active call held by the
Equinox soft-client, with the Avaya Equinox soft-client unable to merge the active calls
together into conference. This issue was only seen on the Avaya Equinox for Windows soft-
client. There is no current work-around; if the conference feature is needed on an Avaya soft-
client for IP office the Avaya Communicator for windows soft-client could be used until this
issue is resolved by Avaya. This issue is under investigation by Avaya.
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e Outbound call from an enterprise extension to a busy PSTN number — Claro did not
send a “486 Busy Here” message on an outbound call to a PSTN station that was busy, as
expected. There was no direct impact to the user, who heard busy tone.

e No matching codec on outbound calls: If an unsupported audio codec is received by Claro
on the SIP Trunk (e.g., 722-64K), Claro will respond with “500 Server Internal Error”
instead of “488 Not Acceptable Here”, the user will hear re-order. This issue does not have
any user impact, it is listed here simply as an observation.

2.3 Support

For support on Claro systems visit the corporate Web page at:
http://www.claro.com.do/wps/portal/do/sc/empresas

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration

Figure 1 below illustrates the test configuration used. It shows a simulated enterprise site connected
to Claro’s network through the public internet.

For confidentiality and privacy purposes, actual public IP addresses and PSTN routable phone
numbers (DIDs) used during the compliance testing have been replaced with fictitious IP addresses
and PSTN non-routable phone numbers throughout the Application Notes.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500v2.
e Avaya IP Office Application Server running Avaya Voicemail Pro, Avaya one-X® Portal for

IP Office and Avaya WebRTC Gateway.

Avaya Session Border Controller for Enterprise.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 11x0 Series SIP IP Deskphones.

Avaya Communicator for Windows.

Avaya Equinox for Windows.

Avaya Communicator for Web.

Avaya 1408 and 9508 Digital Deskphones.

Located at the edge of the enterprise is a VPN Firewall, followed by the Avaya SBCE. The Avaya
SBCE has two physical interfaces, interface B1 is used to connect to the public network, interface
Al is used to connect to the private network. Since a VPN connection was used with this solution to
connect Claro’s network to the enterprise networks, the Al interface was used for access to the
private enterprise network and to route calls to Claro’s network across the VPN tunnel. In this
solution, the B1 interface was used for remote workers access to the enterprise. The configuration
required for the B1 interface is not discussed in this document.

When a VPN connection is not used, the B1 interface is normally used for remote workers access to
the private network and to route calls to the Service Provider across the public Internet.
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All SIP and RTP traffic entering or leaving the enterprise flows through the Avaya SBCE and
through the VPN Firewall. The Avaya SBCE provides network address translation at both the IP and
SIP layers. The transport protocol between the Avaya SBCE and Claro, through the VPN Tunnel,
and across the public Internet, is SIP over UDP. The transport protocol between the Avaya SBCE
and IP Office, across the enterprise private IP network, is SIP over TLS.

For inbound calls, the calls flowed from Claro’s network to the Avaya SBCE through the VPN
Tunnel, then to IP Office.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls across
the SIP trunk to Claro’s network (refer to Section 5.7). The short code 9 was stripped off by IP
Office but the remaining N digits were sent unaltered to the network.

In an actual customer configuration, the enterprise site may include additional network components
between the service provider and the Avaya IP Office system, such as a session border controller or
data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that all SIP and RTP traffic between the
service provider and the Avaya IP Office system must be allowed to pass through these devices.
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Figure 1: Avaya Interoperability Test Lab Configuration.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration.

Equipment/Software | Release/Version
Avaya

Avaya IP Office 500v2 11.0.0.0 Build 849
Avaya IP Office DIG DCPx16 V2 11.0.0.0 Build 849
Avaya IP Office Manager 11.0.0.0 Build 849
Avaya IP Office Application Server 11.0.0.0 Build 849

= Voicemail Pro 11.0.0.0 build 481

=  Avaya WebRTC Gateway 11.0.0.0 build 849

= Avaya one-X® Portal for IP Office 11.0.0.0 build 457
Avaya Session Border Controller for Enterprise 7.2.2.0-05-14222
(running on Portwell CAD-0208 platform)
Avaya 96x1 Series IP Deskphones (H.323) Version 6.6604
Avaya 1140E IP Deskphones (SIP) SIP1140e Ver. 04.04.23.00
Avaya Communicator for Windows 2.1.4.0
Avaya Equinox™ for Windows 3.4.0.152.46
Avaya Communicator for Web 1.0.16.2220
Avaya Digital Deskphones 1408 R48
Avaya Digital Deskphones 9508 R60
Lucent Analog Phone --

Claro

IMS Huawei CSCF-BCF V100R010C00SPC100
SBC Huawei SBC2900 V300R002C00SPC200

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500v2 also when deployed with all configurations of IP Office Server Edition.
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5. Configure IP Office

This section describes the IP Office configuration required to interwork with Claro. IP Office is
configured through Avaya IP Office Manager (IP Office Manager) which is a PC application. On the
PC, select Start - Programs > IP Office = Manager to launch IP Office Manager. A screen that
includes the following may be displayed.

WELCOME to IP Office Administration

What would you like to do?

Create an Offline Configuration

| Open Configuration from System|

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File = Open Configuration at the top of the Avaya
IP Office Manager window. Select the proper IP Office from the pop-up window, and log in with the
appropriate credentials.

The appearance of the Avaya IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane on
the left side, omit the Group pane in the center, and show the Details pane on the right side. Since
the Group pane has been omitted, its content is shown as submenus in the Navigation pane. These
panes (Navigation and Details) will be referenced throughout the IP Office configuration. All
licensing and feature configuration that is not directly related to the interface with the service
provider is assumed to already be in place.

In the sample configuration, the MAC address 00E00706530F was used as the system name. All
navigation described in the following sections (e.g., License = SIP Trunk Channels) appears as
submenus underneath the system name 00E00706530F in the Navigation Pane.
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5.1 Licensing

The configuration and features described in these Application Notes require the IP Office system to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact
an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity, click License in the
Navigation pane and examine SIP Trunk Channels in the Detail pane. Confirm that there is a valid

license with sufficient “Instances” (SIP Trunk Channels) in the Details pane.

| IP Offices |
8 BOOTF () License | Remote Server
F#-g% Operator (3
=B =| 00E00706530F License Mode License Normal

E‘".L?f--ffftﬂeﬂrgt]%;%SguF Licensed Version 11.0

T Line (5) PLDS Host ID

(-2 Control Unit (4) ) )

-4 Extension (37) PLDS File Status ~ Valid

BB User (32)

Egﬁ El":m;ltpctl?j ©7) Feature Key Instances Status
ort Code
@ Service (0) Mobile Worker MN/A 384 Valid

oy RAS (1) Office Worker MN/A 384 Valid

EJ-"@ Incoming Call Route (4) Avaya Softphone Licence MN/A 100 Valid
-4 "[';'_’AN Port (0) VMPra TTS (Scansoft) 7 40 Valid
o Ti';::;gé?e) - VMPro TTS Professional N/A 40 Valid

EJ---@ Firewall Profile (1) IPSec Tunnelling MN/A 1 Valid

[+l IP Route (4) Power User N/A 384 Valid
- Account Code (0) Awaya IP endpoints MN/A 384 Valid
~Realicense (102) IP500 Voice Networking Channels  N/A 22 Valid
¥ Tunnel (©0) SIP Trunk Channels | /A |128 | Valid

E-fg User Rights (8)

Gl g ARS (1) IP500 Universal PRI (Additional cha... N/A 100 Valid
i3 Location (0) CTI Link Pro MN/A 1 Valid
m Authornzation Code (0) Wave User MAA 16 Valid

3rd Party IP Endpoints N/A 384 Valid

5.2 System

Configure the necessary system settings. In an Avaya IP Office, the LANZ tab settings correspond to
the Avaya IP Office WAN port (public network side) and the LAN1 tab settings correspond to the
LAN port (private network side). For the compliance test, the LANL1 interface was used to connect
IP Office to the enterprise private network (LAN), LAN2 was not used.

5.2.1 System - LAN1 Tab

In the sample configuration, the MAC address 00E00706530F was used as the system name and the
LAN port connects to the inside interface of the Avaya SBCE across the enterprise LAN (private)
network. The outside interface of the Avaya SBCE connects to Claro’s network via the public
internet. The LAN1 settings correspond to the LAN port in IP Office. To access the LANL1 settings,
navigate to System (1) = 00E00706530F in the Navigation Pane, then in the Details Pane navigate
to the LAN1-> LAN Settings tab. The LANL1 settings for the compliance testing were configured
with following parameters:

e Set the IP Address field to the LAN IP address, e.g., 192.168.128.167.
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e Setthe IP Mask field to the subnet mask of the enterprise private network, e.g.,
255.255.255.0.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

i

IP Offices =

00EO00706530F

=& BOOTP (6)

f-45% Operator (3) | System ||-AN1 LAMNZ2 | DNS | Voicemail | Telephony | Directory Services | Systemn Events |

=-5{ D0ED0706530F LAN Settings |VolP | Network Topology|
=) “= System (1)
L33 DOEDOT06530F IP Address 192 . 168 . 128 . 167
B4 Line (5)
H-2= Control Unit (4:] IP Mask 255 . 255 . 255 . 0
(-4 Extension (37) .
. 6o .0 .0 . 0
EJ-"ﬂ User (32) Primary Trans. IP Address
-8 Group (1) RIP Mode [None -
8% Short Code (57)
----- B Senvice () [] Enable NAT
Bl RAS (1)
Ej-..e Incoming Call Route (4) Murnber Of DHCP IP Addresses 200 &
""" @ wan port (0) DHCP Mode
----- #% Directory (0)

----- £33 Time Profile (0) © Sever () Client () Dislln © Disabled

E--@®) Firewall Profile (1)
-l IP Route (4)

----- 88 Account Code (0)

----- e License (102)

----- @& Tunnel (0]

E]---#-i User Rights (8)

B¢ ARS (1)

----- &8 Location (0)

----- m Authorization Code (0)
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The VoIP tab as shown in the screenshot below was configured with following settings:

Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the
H.323 protocol to register.

Select Preferred under H.323 Signaling over TLS. When enabled, TLS is used to secure
the registration and call signaling communication between IP Office and endpoints that
support TLS. The H.323 phones that support TLS are 9608, 9611, 9621, and 9641 running
firmware version 6.6 or higher.

Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to Claro.
Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register using
the SIP protocol.

Enter the Domain Name of the enterprise under SIP Domain Name.

Enter the SIP Registrar FQDN of the enterprise under SIP Registrar FQDN.

Check TLS and verify the TLS Port numbers under Layer 4 Protocol is set to 5061.
Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

In the Keepalives section at the bottom of the page, set the Scope field to RTP-RTCP,
Periodic Timeout to 30, and Initial keepalives to Enabled. This will cause the IP Office to
send RTP and RTCP keepalive packets at the beginning of the calls and every 30 seconds
thereafter if no other RTP/RTCP traffic is present.

All other parameters should be set according to customer requirements.

Click OK to commit (not shown).

IP Offices |E 00E00706530F

BOOTP (6)
Operator (3)

| System | LANI|uanz | DNS | Voicemail | Telephony | Directory Senvices | System Events | smTe | sMDR [vem | Vel | volP Security

§5om

-8
ey

0E00706530F [ Lan settings | VolP | Network Topology |
% System (1)

55 DOEDOF06530F H.323 Gatekeeper Enable

-1 Line (3) . [[] Auto-create Extension Auto-create User H.323 Remote Extension Enable
= Control Unit (4)

-4 Bdension (37) [H323 Signaling over TLS Preferred | « Remote Call Signaling Port 1720
§ User(32
-igk Grou|
3 Shmpgijde ©7) SIP Trunks Enable
@ Service (0)
~olls RAS (1)
@ Incoming Call Route (4) [[] Auto-create Extension/User SIP Remote Extension Enable
2 WAN Port (0)
om Directary (0) SIP Domain Name avaya.lab.com
{‘\ Time Profile (0)
@ Firewall Profile (1) SIP Registrar FQDMN avaya.lab.com
il IP Route (4)
-8 Account Code (0) UDP UDP Port 5060 = Remote UDP Port 5060
% License (102)
i Tunnel (0) Layer 4 Protocol Tcp TCP Port [5060 z Remote TCP Port 5060
5 User Right =
ﬁ(. A:{esr(ll)g 0 s TLSPort  |5061 - Remote TLS Port 5061
i@ Locati
B onermaen Code 0 Craenge Expiaton Time (cec) 19

SIP Registrar Enable

RTP
Part Number Range
Minimum 49152 = Maximum 53246

Port Mumber Range (NAT)
Minimum 49152 = Maximum 53246

Enable RTCP Monitoring on Port 5005
RTCP collector IP address for phones 0 0 0 0

Keepalives

Scope RTP-RTCP = | Periodic timeout 30
Initial keepalives Enabled -

Note: In the compliance test, the LANL1 interface was used to connect IP Office to the enterprise
private network (LAN), LAN2 was not used.
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5.2.2 System - Telephony Tab
Navigate to the Telephony - Telephony tab in the Details Pane, configure the following

parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call

transfers to the PSTN via the SIP trunk to the service provider.
e All other parameters should be set according to customer requirements.
e Click OK to commit (not shown).

IP Offices ‘ = 00E00706530F
’: E]OOTf (5()3] | system | Lana | Lan2 | DNs | voicemail | Telephony | Directory Services | System Events | smp | sMDR [veM | volp | volP Security
-{% Operator

-2 00E00706530F Telephony | park & Page| Tones & Music| Ring Tones M | callLog [ TUl |

o= System (1)
L. O0EDOTO6520F Analogue Extensions Companding Law
H-F4 Line (5) Switch Line
tl-<2r Control Unit (4) Default Qutside Call Sequence [Normal ']
H-4 Extension (37) _ _ .
- User(32) Default Inside Call Sequence [Ring Typel V] @ U-law @ U-Law Line
]2 SI':Z:tpC%Le 7) Default Ring Back Sequence [Ring Type2 ']
i @ AL © A-LawLi
B Service (0) Restrict Analogue Extension Ringer Voltage a ) ™ i av e
H-ally RAS (1)
=) e Incoming Call Route (4)
?ﬂ \['J\TAF:tPortm(()J) Dial Delay Time (sec) 3 = 0 DSS Status
irectory
. . V!
Lt T.Ime PerI|E.f0] Dial Delay Count U : futo Held
-8} Firewall Profile (1) _ - Dial By Narme
-l IP Route (4) Default Mo Answer Time (sec) 20 =
-8 Account Code (0) — Show Account Code
B License (102) Hold Timeout (sec) 0 =
- Tunnel — [T Inhibit Off-Switch Forward/Transfer
H-fg User Ri;ﬂis ) Park Timeout (sec) 300 = I
0 ARS (1) 5 = [T Restrict Network Interconnect
. Ring Delay (sec) 0

-8 Location m - Include location specific information
% Authorization Code (0) Call Priority Promotion Time (sec) |Disabled =
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5.2.3 System — VoIP tab

For Codec settings, navigate to the System (1) - 00E00706530F in the Navigation Pane, select the
VoIP tab and configure the following parameters:

e Select or enter 101 for RFC2833 Default Payload. This setting was recommended by Claro
for use with out-of-band DTMF tone transmissions.

e For codec selection, select the codecs and codec order of preference on the right, under the
Selected column. The Default Codec Selection area enables the codec preference order to be
configured on a system-wide basis. The buttons between the two lists can be used to move
codecs between the Unused and Selected lists, and to change the order of the codecs in the
Selected codecs list. By default, all IP phones (SIP and H.323) will use the system default
codec selection shown here, unless configured otherwise for a specific extension. The
example below shows the codecs used for IP phones (SIP and H.323). The system’s default
codecs and order was used.

IP Offices = 00E00706530F

=-K BOOTP (6)
4% Operator (3)
=] 00E00706530F Ignore DTMF Mismatch For Phones 0
El{% System (1)

-+ DOEDOTO6530F
H-T9 Line (5)

1< Control Unit (4) |RFC2833 Default Payload 101 | =
t-4 Extension (37)
Ja User (32) Available Codecs Default Codec Selection

153§ Group (1) Unused Selected

1-8% Short Code (67) G711 ULAW 64K G722 64K . G.711 ULAW 64K

E;E ;:’;'ae] © G711 ALAW 64K G711 ALAW 64K

- Incoming Call Route () G.722 64K G.729(a) 8K CS-ACELP
.729(a) 8K C5-ACELP 67231 6K3 MP-MLQ

----- 428 WAN Port (0) : ’
_____ = Directory (0) 6.723.1 6K3 MP-MLQ >y

L7 Time Profile (0)
(-8} Firewall Profile (1)
-Jill 1P Route (4)

..... 8 Account Code (0) B
----- % License (102)

----- &% Tunnel (0)

i-f5 User Rights (8)

- ARS (1)

----- &8 Location (0)

----- 28 Authorization Cade (0)

| System [ LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | sMTP | sMDR [vem | VolP 1]

Allow Direct Media Within NAT Location  []

o O O O e W e O

Note: The codec selections defined under this section (System — VoIP Tab) are the codecs selected
for the IP phones/extensions. The codec selections defined under Section 5.4.4 (SIP Line — VVolP
tab) are the codecs selected for the SIP Line (Trunk).
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5.2.4 System — VoIP Security Tab

Secure Real-Time Transport Protocol (SRTP) refers to the application of additional encryption and
or authentication to VolIP calls (SIP and H.323). SRTP can be applied between telephones, between
ends of an IP trunk or in various other combinations.

Configuring the use of SRTP at the system level is done on the System VolP Security tab using the
Media Security setting. The options are:

e Disabled (default).

e Preferred.

e Enforced.

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP
Office uses SRTP if supported by the far-end, otherwise uses RTP. If the Enforced setting is used,
and SRTP is not supported by the far-end, the call is not established.

To configure the use of SRTP, navigate to the System (1) = 00E00706530F in the Navigation Pane,
select the VoIP Security tab and configure the following parameters:

e Under Media select Preferred from the pull down menu.

e Verify that Strict SIPS is not checked.

e Under Media Security Options ensure that RTP is checked under Encryptions and

Authentication.
e Under Crypto Suites ensure that SRTP_AES_CM_128 SHAL 80 is checked.
e Click OK to commit (not shown).

IP Offices | E 00E00706530F

- R BOOTP ()
---:@ Operator (3)

System | LAN1 [LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | sMTP | sSMDR [vem [ volp | VolP Security

) Bf PS.JE[;[;rjs[t]:::[(]lF] Media [Preferred v] [C] strict sIPS
-9 0EQ0T06530F
e Line (5)
t-<=r Control Unit (4)
-4 Extension (37) Media Security Options
2 a User (32) Encryptions RTP
- Group (1) &
H-8% Short Code (67) RTCP
@ Service (0) Authentication RTP
]@ Incoming Call Route (4) RTCP
@ WAN Port (0} Replay Protection
- Directory (0) SRTP Window Size 64
~£2) Time Profile (0) Crvpto Suites
i:% ;’;‘;"j't':(;”)f"e @ SRTP_AES_CM_128_SHAL 80
& Account Code (0) [7] SRTP_AES_CM 128 SHA1 32

W License (102)

i Tunnel (0)

H-fig User Rights (8)

H-" " ARS (1)

- fig | ocation (0)

ﬂ Authorization Code (0)
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5.3 IP Route

Create an IP route to specify the IP address of the gateway or router where IP Office needs to send
the packets in order to route calls to Claro’s network (if located in a different IP subnet).

In the reference configuration, the IP Office LANL1 interface and the private interface of Avaya
SBCE resided in different IP subnets, so an IP route was necessary to specify the IP address of the
gateway or router where IP Office needs to send the packets, in order to reach the IP subnet of the
private interface of Avaya SBCE.

To create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to reach the IP subnet where the Avaya SBCE resides (if located in
different IP subnets), on the left navigation pane, right-click on IP Route and select New.

e Setthe IP Address and IP Mask of the IP subnet of the private side of the Avaya SBCE, or

enter 0.0.0.0 to make this the default route.

e Set Gateway IP Address to the IP Address of the default router in the IP Office IP subnet.

e Set Destination to LAN1 from the pull-down menu.

e Click OK to commit (not shown).

IP Offices = 0.0.0.0

=& BOOTP (6) IP Route

F-{% Operator (3)

- m 1P Address 0 0o .0 0
(=550 Systemn (1)

y 00E00706530F 1P Mask ° ’ ’ ’
-1 Line (5) Gateway IP Address 192 . 168 . 128 . 200
[#-*2» Control Unit (4)
-4 Extension (37) Destination l'—*"‘”l
G-§  User (32)
[
[

558 Group (1) Metric 0

H-@% Short Code (67)

_____ @ Service 0) [T Proxy ARP
[-olfs RAS (1)

(- Incoming Call Route (4)
----- E8 WAN Port (0)

----- @ Directory (0]

£ Time Profile (0]

(- Firewall Profile (1)

IP Route (4)

m

----- @8 Account Code (0)

----- % License (102)

""" @& Tunnel (0)

G-f User Rights (8)

- ARS (1)

----- &8 Location (0)

----- m Authorization Code (0)
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5.4 SIP Line

DevConnect generated SIP Line templates are always exported in an XML format. These XML
templates do not include sensitive customer specific information and are therefore suitable for
distribution. The XML format templates can be used to create SIP trunks on both IP Office Standard
Edition (500 V2) and IP Office Server Edition systems. Alternatively, binary templates may be
generated. However, binary templates include all the configuration parameters of the Trunk,
including sensitive customer specific information. Therefore, binary templates should only be used
for cloning trunks within a specific customer’s environment.

Copy a previously created template file to a location (e.g., \temp) on the same computer where IP
Office Manager is installed.

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then navigate
to New - New from Template->Open from file.

=& BOOTP (6) SIP Line | Transport| Call Details |VolP [ T38 Fax|SIP Credg

4% Operator (3)

-2 00E00706530F Line Nurnber 17 z
I voip.centurylin
=R L
: T= _ & Cut Ctrl+X

53 Copy Ctrl+C
_ SIP URI
, Paste Ctrl+V
| 7¢ Delete Ctrl+Del Cloud
Co ./ Validate

Connect To... Ctrl+T

Mew from Template Open from file

- - -
-3 el

5h Export as Template
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Navigate to the directory on the local machine where the template was copied and select the
template.

" Open

@th v Computer » TOSHIBA (F:) » Claro Dominican Republic » 2018 testing » TR9843 - PO 11.0 & ASBCE 7.2.2 with Claro » Template
Organize v New folder

==

- | 4,.| | Search Template el |
=

r Favorites Neme

Date modified
Bl Desktop

Type
(2] ClarolPO11SBCT2.xml

#- 0 @
Size
4 Downloads

4 KB

7/18/2018 9:30 AM

XKML Document
=] Recent Places

1% Computer
&, Avaya eSOE (C)
= 1OSHIBA (E)
&= TOSHIBA (F)
ﬂ"! Netwaork

File name:

+ [ Template Files ami) -]

[ open ][ conca |

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK

e

Ternplate Provisicning @
I_o:l Mew SIP Trunk created successfully using selected template.

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

=& BOOTP (5)
[-¢#% Operator (3
1530 System (1)

539 DED0706530F
=8

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.4.1 to 5.4.7.
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5.4.1 SIP Line - SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e |eave the ITSP Domain Name blank. Note that if this field is left blank, then IP Office
inserts the ITSP Proxy Address from the Transport tab as the ITSP Domain in the SIP

messaging.

e Verify that URI Type is set to SIP.

e Verify that In Service box is checked, which is the default value. This makes the trunk
available to incoming and outgoing calls.

o Verify that Check OOS box is checked, the default value. IP Office will use the SIP

OPTIONS method to periodically check the SIP Line.
e Verify that Refresh Method is set to Auto.

e Verify that Timer (seconds) is set to On Demand.
e Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing

Supervised REFER to Never (refer to Section 2.2).
e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices

R

SIP Line - Line 17

- #& BOOTP ()

>

B-

Operator (3
00E00T06530F

(-2 System (1)
g

(-2 Control Unit (4)
(-4 Extension (37)
B-§  User 32)
(-5 Group (1)
(-8 Short Code (67)

oy RAS (1)

-4 Incoming Call Route (4)
----- $8 WAN Port (0)

----- #m Directory (0)

£ Time Profile (0)

(-8 Firewall Profile (1)
&-ill IP Route (4)

----- #m Account Code (0]

----- % License (102)

""" & Tunnel (0)

[#-§5 User Rights (8)

- ARS (1)

""" & Location (0)

----- m Authorization Code (0)

SIP LiﬂElTransporthaII DetailslVoIP |T38 FaxlSIP CredentialslSIP AdvancedlEngineering|

Line Mumber

17 =

-

|1TSP Dormain Name

Local Domain Name

In Service

Check 005

|URIType

[ste urt

Location

Prefix

Mational Prefix
International Prefix
Country Code
Mame Priority

Description

[Cloud

Systern Default

Session Timers
Refresh Method

Timer (sec)

Auto

On Demand

Redirect and Transfer

Incoming Supervised REFER

Outgoing Supervised REFER

[Never

’Never

Send 302 Moved Temporarily
Outgoing Blind REFER

o
o
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5.4.2 SIP Line - Transport Tab

Select the Transport tab; configure the parameters as shown below:

e Setthe ITSP Proxy Address to the inside IP Address of the Avaya SBCE or 10.64.101.243

as shown in Figure 1.
e Set the Layer 4 Protocol to TLS.
e Set Use Network Topology Info to None (see note below).
e Setthe Send Port to 5061.

e Default values may be used for all other parameters.
e Click OK to commit (not shown).

IP Offices T

SIP Line - Line 17*

- & BOOTP (8)

|SIP Line| Transport [Call Details| VolP | T38 Fax|SIP Credentials | SIP Advanced|Engineering

-4 Operator (3)
=) 00EQQTO6530F

; | ITSP Proxy Address  10.64.101.243 |
=537 System (1)

[H-“=r Control Unit (4]
-4 Extension (37) Calls Route via Registrar
@ User (32)

-if Group (1)
[H-@% Short Code (67)

_____ @ service (0) Separate Registrar

. s QQED0706530F —

L MNetwork Configuration

=-{Line &) ?
o a1 Layer4 Protocol [TLS v] Send Port  |5061
- ."‘2
= Use Network Topology Info [None v] Listen Port 2061
-y 18
-y 19 Explicit DNS Server(s) 0 0 0 0 0 0 0

Note — For the compliance testing, the Use Network Topology Info field was set to None, since no
NAT was used in the test configuration. In addition, it was not necessary to configure the System 2>
LAN1 - Network Topology tab for the purposes of SIP trunking. If a NAT is used between Avaya
IP Office and the other end of the trunk, then the Use Network Topology Info field should be set to
the LAN interface (LAN1) used by the trunk and the System = LAN1 -> Network Topology tab

needs to be configured with the details of the NAT device.
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5.4.3 Call Details Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept on
this line. Select the Call Details tab, and then click the Add... button and the screen shown below
will appear. To edit an existing entry, click an entry in the list at the top, and click the Edit... button.
In the example screen below a new entry was added. For the compliance test, a single SIP URI entry
was created that matched any DID number assigned to an IP Office user. The entry was created with

the parameters shown below:

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. The outgoing line group number is used in defining short codes for routing
outbound traffic to this line. For the compliance test, a new incoming and outgoing group 17

was defined that only contains this line (line 17).

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP

URI pattern.
e Set the Credentials field to 0:<None>

e Set the Local URI, Contact, P Asserted ID and Diversion Header fields to the values

shown in the screenshot below.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).
e Click OK to commit again (not shown).

' SIP Line - 17 | Call Details | SIP URI =
New URI
Incoming Group 17 w  Max Sessionz o :
Outgoing Group 17 -
Credentials 0: <None> A
Display Content Field meaning
Outgoing Calls Forwarding/ Twinning Incoming Calls
Local URI Use Intemal Data » Uselntemal Data [Caller ,] [Original Caller ,] [Called v]
Contact Use Intemal Data » Uselntemal Data w [Caller ,] [Caller ,] [Called v]
P Asserted ID Use Intemal Data v Ussintemal Data  ~ pone +] [Cater +| [Nore -
PPrefered ID [C] |None Nene None None None
Diversion Header Use Intemal Data » Uselntemal Data [None ,] [Caller ,] [None .]
Remote Party ID  [C] |None None None None None
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5.4.4 SIP Line - VoIP Tab

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e In the sample configuration, the Codec Selection was configured using the Custom option,
allowing an explicit order of codecs to be specified for the SIP Line. The buttons allow
setting the specific order of preference for the codecs to be used on the SIP Line. As shown,
the codec order of G.711 ULAW, G.711 ALAW and G.729(a) were selected for audio.

e Set Fax Transport Support to T.38.

e Set the DTMF Support field to RFC2833. This directs IP Office to send DTMF tones using
RTP events messages as defined in RFC2833.

e Set the Media Security field to Same as System (Preferred).

e Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on the
trunk.

e Check the PRACK/100rel Supported box.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices |E SIP Line - Line 17
3 SOOTP (ﬁ()ﬂ |SIP LmelTranspor‘thaH Detallsl VolP IT38 Fa)(lSIP Credentials|SIP Advanced Engmeermg|
[H--goe perator
_ [T] VolP Silence Suppression
::":ﬁl) [ Local Hold Music
. Codec Selection  [Custom | v
Unused Selected ] Codec Lockdown
6.722 64K s G711 ULAW 64K
. G.7231 6K3 MP-MLQ G711 ALAW 64K [C] Allow Direct Media Path
(-2 Control Unit (4) G.729(a) 8K CS-ACELP Force direct media with phones
-4 Extension (37)
E-§  User(32) | PRACK/100rel Supported
E 2 Er:ztltpccolfie 67 G.TLL Fax ECAN
@ Service (0)
ol RAS (1)
[ @ Incoming Call Route (4)
@ WAN Port () >
3 St
E é Filrr:;allr;rl;if?(l) Fax Transport Support [T38 'l
& fill 1P Route (4) DTMF Support [RFcasa 1
- A.ccnunt Code (0)
; _“‘_'::::g‘]oz] Media Security [Same as Systemn (Preferred) v]
E 3{- ,L:;esrgijghts @) Advanced Media Security Options Same As Systemn
- Location (0)

m Authorization Code (0)

RTP

RTCP

RTP

RTCP

64

SRTP_AES_CM_126_SHA1_80
[ SRTP_AES_CM_128_SHAL_32
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Note: The codec selections defined under this section (SIP Line — VoIP tab) are the codecs selected
for the SIP Line (Trunk). The codec selections defined under Section 5.2.3 (System — VoIP tab) are
the codecs selected for the IP phones/extension (H.323 and SIP).

5.4.5 SIP Line — T38 Fax Tab
Select the T38 Fax tab, to set the Fax over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below:

e Uncheck the Use Default VValues at the bottom of the screen.

e Setthe T.38 Fax Version to 0, Claro supports T.38 fax version 0.

e Default values may be used for all other parameters.

IP Offices |E SIP Line - Line 17

=K BOOTP (5)
g7 Operator (3)

|SIP LinelTransporthalI DetailslVoIP |T38 Fax |SIP CredentialslSIP AdvancedlEngineering

----- £19 Time Profile (0)
(-8 Firewall Profile (1)
=-ill IP Route (4)

[[] Use Default Values

9---’-3; 00EQO706530F T38 Fax Version [U "]
[-#%7 System (1) Scan Line Fix-up
=-F Line (5 Transport UDPTL
TFOP Enhancement
Redundancy
a2 [C] Disable T30 ECM
"\ Low Speed 0 5 i .
T [C] Disable EFlags For First DIS
i i 0 =
e 19 _ High Speed = [C] Disable T30 MR Compression
#-“2» Control Unit (4)
-4 Extension (37) TCF Method [Trans TCF '] [ MSF Override
E-§  User (32)
-8 Group (1) Max Bit Rate (bps) (14400 - | g
-8 Short Code (67) . -
..... @ Service (0) EFlag Start Timer (ms) 2600 > B
B-olf RAS (1) i 2300 z
- Incoming Call Route (4) EFlag Stop Timer (ms) -
""" Eﬁ WAN Port (0] Tx Metwork Timeout (sec) (130 =
----- . Directory (0)
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5.4.6 SIP Line — SIP Advanced Tab

Select the SIP Advanced tab.
e Verify that Call Routing Method is set to Request URI.
e Check the box for Use PAI for Privacy.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

[#-“=» Control Unit (4)
-4 Extension (37)
-f User 32)
[ ﬂ Group (1)
(@ Short Code (67)
@ Service (0)
o RAS (1)
[ @ Incoming Call Route (4)
~§@ WAN Port (0)
s Directory (0)
~£1% Time Profile (0)
-8 Firewall Profile (1)
-l IP Route (4)
-~ Account Code (0)
-8 License (102)
- Tunnel {0)
@-fy User Rights (8)
- ARS (1)
-8 Location (0)
m Authorization Code (0)

IP Offices & SIP Line - Line 17*
&R BOOTP (6) SIp LmelTransporthaH DetallslVoIP |T38 Fa)(lSIP Credentlalsl SIP Advanced |Eng|neermg|
3 Operator (3
00EDOTOE530F Addressing
Association Method [By Source IP address v]
|Ca\| Routing Method [Requst URI | ']

Suppress DNS SRV Lookups ]

Identity

Use "phone-context”
Add user=phone

Use + for International
IUse PAI for Privacy
Use Domain for PAI

Caller ID from From header

Send From In Clear
Cache Auth Credentials

o 5

User-Agent and Server Headers

=
2
@
4

Send Location Info

Add UUT header
Add UUL header to redirected
calls

o

Media

Allow Empty INVITE [}
Send Empty re-INVITE [}
Allow To Tag Change [}
P-Early-Media Support None
Send SilenceSupp=0ff |

Media Connection
Preservation

Disabled

Indicate HOLD =}

Call Control

Call Initiation Timeout (s) 4 &
Call Queuing Timeout (mins) 5 =

Service Busy Response

486 - Busy Here
on Mo User Responding Send  (408-Request Timeout
Action on CAC Location Limit | Allow Veicemail

Suppress Q.850 Reason ]
Header

Emulate NOTIFY for REFER [
No REFER if using Diversion a
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5.4.7 SIP Line — Engineering tab

A SIP Line Custom String (SLIC) is required for proper operation of T.38 fax calls (see Section
2.2). With this configuration, in the reINVITE for T.38, Avaya IP Office will put the active fax SDP
entry first in the SDP list followed by the inactive audio SDP entry.

To configure a custom string, select the Engineering tab and click Add. The New Custom String
section will appear. In the Custom String field, enter SLIC_PREFER_ACTIVE_SDP. Click OK.

IP Offices |Ei SIP Line - Line 17*

=-R BOOTP (6) |5P Line| Transport| Call Details|VolP  [T38 Fax|SIP Credentials|SIP Advanced|Engineering
3

t-{% Operator (3)
[ D0ED0706530F Custom Strings Add...
=7 Systemn (1)

E'T Remove
a1

w2 Edit...

H-<2r Control Unit (4)
H-48 Extension (37)
H-§  User (32)

]ﬂ Group (1)

H-@M Short Code (67)

i 0 O W W

ol RAS (1)

]@ Incoming Call Route (4)
----- £8 WAN Port (0)

----- s Directory (0)

£ Time Profile (0)

(-8 Firewall Profile (1)
=-J§ll IP Route (4)

----- 8 Account Code (0)

----- % License (102)

""" & Tunnel (0)

(g User Rights (8)

- ARS (1)

""" @ Location (0)

----- ﬂ Authorization Code (0)

o

MNew Custom String

Custom String SLIC_PREFER_ACTIVE_SDP
=N
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5.5 Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line
defined in Section 5.4. To configure these settings, first navigate to User > Name in the Navigation
Pane where Name is the name of the user to be modified. In the example below, the name of the user
is Ext3041 H323. Select the SIP tab in the Details Pane. The values entered for the SIP Name allow
matching of the SIP URI for incoming calls without having to enter this number as an explicit SIP
URI for the SIP Line (Section 5.4.3). The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise by Claro. The SIP Display Name (Alias) parameter can optionally be
configured with a descriptive name. If all calls involving this user and a SIP Line should be
considered private, then the Anonymous box may be checked to withhold the user’s information
from the network. This can also be accomplished by activating Withhold Number on H.323
Deskphones (not shown). Click the OK to commit (not shown).

IP Offices |Ei Ext3041 H323: 3041°
’F BOQTP (6) i | Dial In |‘u’oice Recording | Button Programming | Menu Programming | Mobility | Group Membership Announcementsl sIP |
(-4 Operator (3)
=-+2| 00E00706530F SIP Name 1234569226

714 Line (5) SIP Display Name (Alias) Ext3041 H323
[-<=r Control Unit (4)

(-4 Extension (37) Contact 1234569226
=-§ [User G

RemoteManager

[] Anonymous

3040 Ext3040 H323
i
3042 Ext3042 H323
=@ 3043 B3043 Digital
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5.6 Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system. In a scenario like the one used for the
compliance test, only one incoming route is needed, which allows any incoming number arriving on
the SIP trunk to reach any predefined extension in IP Office. The routing decision for the call is
based on the parameters previously configured for Call Routing Method (Section 5.4.6) and SIP
URI (Section 5.4.3) and the users SIP Name and Contact, already populated with the assigned
Claro DID numbers (Section 5.5).

5.6.1 Incoming Call Route — Standard Tab
To create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New.

On the Standard tab of the Details Pane, enter the parameters as shown below.
e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.

e Default values can be used for all other fields.

IP Offices = 17
a‘ BOOTP (8) Standard | Vioice Recording | Datinations|
B4 Operator (3)
== [00EDOT06530F
-5 System (1) Bearer Capabili Any Voice -
H-14 Line (3) pability l Y
-2 Control Unit (4) Line Group ID 17 -
(-4 Extension (37)
H-§  User (32) Incoming Mumber
u Group (1)
8% Short Code (67) Incoming Sub Address
@ Service (0) .
o RAS (1) Incoming CLI
EI@ Inc%ming Call Route E4:I| Locale ’ vl
@ 18 Priority ll - Low vl
Tag
----- EEWAN Port (0)
..... @ Directory (0) Hold Music Source ’System Source vl
----- £19 Time Profile (0) _ _ N
-} Firewall Profile (1) Ring Tone Override one -
&-Jill 1P Route [4)
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5.6.2 Incoming Call Route — Destinations Tab
e Under the Destinations tab, enter “.” for the Default Value. This setting will allow the call

to be routed to any destination with a value on its SIP Name field, entered on the SIP tab of

that User, which matches the number present on the user part of the incoming Request URI.

e Click OK to commit (not shown).

IP Offices

7

17"

- % BOOTP (8)

w-g7 Operator (3

7 System (1)
117 Line (3)
tl-<2 Control Unit (4)
+|-4 Extension (37)
i@ User (32)
J--a Group (1)
t1-@X Short Code (67)
- @ Service (0)
H-alfy RAS

- @[incoming Cal Routs ]

| Standard |\|’oice Recordingl Destinations

4

TimeProfile Destination

Fallback Extension

| Default Value [ |

|-
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5.7 Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing can
be specified so that a call can re-route automatically if the primary route or outgoing line group is
not available. While detailed coverage of ARS is beyond the scope of these Application Notes, and
alternate routing was not used in the reference configuration, this section includes some basic screen
illustrations of the ARS settings used during the compliance testing.

5.7.1 Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation Pane and
select New. The screen below shows the short code 9N created (note that the semi-colon is not used
here). In this case, when the IP Office user dials 9 plus any number N, instead of being directed to a
specific Line Group ID, the call is directed to Line Group 50: Main, which is configurable via
ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N was
used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group ID to 50: Main to be directed to Line Group 50: Main, which is
configurable via ARS.
e Click the OK to commit (not shown).

IP Offices F 9N: Dial*
----- B 33N + || Short Code
..... “ *34[.'].:
..... “ *BS*N# ':Elle QN
..... “ *36
----- B “37NE Feature |Dia|
----- X 35N
..... B *39 Telephone Mumber M
----- % =40 )
o]
..... “ =41 Line GF'I"-'F] o m
""" B =42 Locale |
..... “ =43
----- x 44 Force Account Code
'''' B 457N Force Authorization Code
..... “ *45 Heerere
..... ; : k
[oxcon
----- % FMEDD E
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 31 of 87

SPOC 8/20/2018 ©2018 Avaya Inc. All Rights Reserved. ClarolPO11SBC72



The following screen shows a sample ARS configuration for the route 50: Main. Note the sequence
of X’s used in the Code field of the entries to specify the exact number of digits to be expected,
following the access code and the first set of digits on the string. This type of setting results in a
much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation Pane and
click Add (not shown).

In the Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits.

Set Feature to Dial. This is the action that the short code will perform.

Set Telephone Number to 1N. The value N represents the additional number of digits dialed
by the user after dialing 1 (The 9 will be stripped off).

Set the Line Group ID to the Line Group number being used for the SIP Line, in this case
Line Group ID 17 was used.

Set the Locale to the specific country and language, in this case United States (US English).
Click OK to commit.

Edit Short Code

Code 100000000
Feature Dial -

Telephone Mumber 1N

Line Group ID 17 -

Locale | United States (US Engish)  +

Force Accourt Code O

Force Authorization Code [

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out from
IP Office.
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The highlighted entry below of 1 plus 10 digits (represented by 10 X’s) was used to make call within
the North American Numbering Plan (NANP).

The user dialed 9, followed by 1 and 10 digits (represented by 10 X’s). The 9 is stripped off, the
remaining digits, including the 1, are included in the SIP INVITE message IP Office sends to Claro.

IP Offices IE Main RIS
&=-& BOOTP (5) ARS
El-g% Operator (3)
: m ARS Route ID 50 Secondary Dial tone
557 Systern (1)
‘H ES:t(rSUJI Unit (4) Route Name Main [Sﬁﬁe"“—r"”e
-4 Extension (37)
B User(32) Dial Delay Time System Default (3) z Check User Call Barring
-3 Group (1)
8 Short Code (66) .
(B Service (0) Description
-olls RAS (1)
@ Incoming Call Route (4)
£8 WAN Port (0) In Service QOut of Service Route l<None> ']
a4 Directory (0)
£ Time Profile (0) 1
2 Firewall Profile (1) Time Profile <MNonex et Quit of Hours Route [<None> ']
-l IP Route (4)
8 Account Code (0) l
% License (102)
: El:;ﬂ;: f.lilis ) Code Telephone Number Feature Line Group ID -
_..‘(Iims ] Juocoosoox 1N Dial 17 P
LI 50: Main GO0 6N Dial 17 ﬂ
- Location (1) IXHCHKA 3N Dial 17
~ 4 Authorization Code (0) 280N 28N Dial 17
SOCOO00( 55N Dial 17
OLCOCCOOOOCCNX. 01N Dial 17
04X 04N Dial 17 i
4 mn L3
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 33 of 87
SPOC 8/20/2018 ©2018 Avaya Inc. All Rights Reserved. ClarolPO11SBC72



5.8 Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

HG; Reviewed:
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r

Save Configuration

IP Office Settings

ol ® )|

DOEOO706530F

Configuration Reboot Mode

@ Merge
Immediate
When Free
Timed

Reboot Time

13:19

Call Barring

OK

l | Cancel | |

Help
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the required configuration of the Avaya SBCE to connect to Claro SIP
Trunking Service.

It is assumed that the Avaya SBCE was provisioned and is ready to be used; the configuration shown
here is accomplished using the Avaya SBCE web interface.

Note: In the following pages, and for brevity in these Application Notes, not every provisioning step
will have a screenshot associated with it. Some of the default information in the screenshots that
follow may have been cut out (not included) for brevity.

6.1 Log in Avaya SBCE

Use a Web browser to access the Avaya SBCE Web interface. Enter https://<ip-addr>/sbc in the
address field of the web browser, where <ip-addr> is the Avaya SBCE management IP address.

Enter the appropriate credentials and click Log In.

o v o a Log In
Username: username

Password:
Log In
Session Border Controller WELCOME TO AVAYA SBC
for Ente rprise Unauthorized access to this machine is prohibited. This system is for

the use authorized users only. Usage of this system may be monitored
and recorded by system personnel.

Anyone using this system expressly consents to such monitoring and
is advised that if such monitoring reveals possible evidence of criminal
activity, system personnel may provide the evidence from such
monitoring to law enforcement officials.

© 2011 - 2017 Avaya Inc. All rights reserved.
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The Dashboard main page will appear as shown below.

Alarms  Incidents  Status~ Logs~  Diagnostics  Users Settings v Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard

Administration
Backup/Restore
System Management

Global Parameters
Global Profiles The following certificates are expired:

+ Clearcom_Cert.crt (Certificate)

> PPM Services

> TLS Management System Time 04:25:22 PM EDT Refresh EMS

> Device Specific Settings Version 7220-11-15522 Avaya SBCE
Build Date Tue May 29 11:31:10 UTC 2018
License State @ 0K

Aggregate Licensing Overages 0

Peak Licensing Overage Count 0

Last Logged in at 07/11/2018 16:05:44 EDT

Failed Login Attempts 0

Active Alarms (past 24 hours) Incidents (past 24 hours)

None found Avaya_SBCE : No Subscriber Flow Matched

Avaya_SBCE : No Subscriber Flow Matched v

To view the system information that was configured during installation, navigate to System
Management. A list of installed devices is shown in the right pane. In the compliance testing, a
single Device Name Avaya SBCE was already added. To view the configuration of this device,
click on View as shown in the screenshot below.

Alarms  Incidents  Status~ Logs ~  Diagnostics  Users Settings ~ Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard System Management

Administration

Backup/Restore
System Management Devices H Updates u SSL VPN I_I Licensing H Key Bundles

Global Parameters Management
Global Profiles <

Device Name

Version Status

» PPM Services Avaya SBCE ?52552‘}”’ Commissioned Reboot Shutdown Restart Application Edit Uninstall
> Domain Policies
> TLS Management
> Device Specific Settings
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The System Information window is displayed as shown below.

The System Information screen shows the Network Configuration, DNS Configuration and
Management IP(s) information provided during installation and corresponds to Figure 1. The Box
Type was set to SIP and the Deployment Mode was set to Proxy. Default values were used for all
other fields.

System Information: Avaya_SBCE X
General Configuration Device Configuration ———— - License Allocation
Appliance Name Avaya_SBCE HA Mode No Standard Sessions 2000
Requested: 2000
Box Type SIP Two Bypass Mode No i
Advanced Sessions 2000

R ted: 2000
Deployment Mode  Proxy equeste:

Scopia Video Sessions
Requ%sted: 500 500

CES Sessions 0
Requested: D

Transcoding Sessions
Reguested: 0

CLID
Encryption
Aval I?I':Pe: Yes S
- Network Configuration
P Public IP Network Prefix or Subnet Mask Gateway Interface
10.64.101.159 10.64.101.159 255.265.2550 10.64.101.53 Al
10.64.101.243 10.64.101.243 255.255.255.0 10.64.101.53 Al

A1l

B1

B1

B1

- DNS Configuration Management IP(s)

Primary DNS 8888 IP #1 (IPv4)

Secondary DNS  7.7.7.7
DNS Location DMZ

DNS Client IP 10.10.80.51

On the previous screen, note that the Al corresponds to the inside interface (Private Network side)
and B1 corresponds to the outside interface (Public Network side) of the Avaya SBCE. Since a VPN
connection was used with this solution to connect Claro’s network to the enterprise network, the Al
interface was used for access to the private enterprise network and to route calls to Claro’s network
across the VPN tunnel. In this solution, the B1 interface was used for remote workers access to the
enterprise. The configuration required for the B1 interface is not discussed in this document. (Refer
to Figure 1).

When a VPN connection is not used, the B1 interface is normally used for remote workers access to
the private network and to route calls to the Service Provider across the public Internet.
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6.2 TLS Management

Transport Layer Security (TLS) is a standard protocol that is used extensively to provide a secure
channel by encrypting communications over IP networks. It enables clients to authenticate servers
or, optionally, servers to authenticate clients. UC-Sec security products utilize TLS primarily to
facilitate secure communications with remote servers.

For the compliance testing, the transport protocol that was used between IP Office and the Avaya
SBCE, across the enterprise private IP network (LAN), was SIP over TLS. SIP over UDP was used
between the Avaya SBCE and Claro, across the public Internet.

It is assumed that generation and installation of certificates and the creation of TLS Profiles on the

Avaya SBCE have been previously completed, as it’s not discussed in this document. Refer to item
[10] in Section 10.

6.3 Global Profiles

The Global Profiles Menu, on the left navigation pane, allows the configuration of parameters across
all Avaya SBCE appliances.

6.3.1 Server Interworking — Avaya-IPO

Interworking Profile features are configured to facilitate interoperability of implementations between
enterprise SIP-enabled solutions and different SIP trunk service providers.

Several profiles have been already pre-defined and they populate the list under Interworking
Profiles on the screen below. If a different profile is needed, a new Interworking Profile can be
created, or an existing default profile can be modified or “cloned”. Since directly modifying a
default profile is generally not recommended, for the test configuration the default avaya-ru profile
was duplicated, or “cloned”. If needed, the profile can then be modified to meet specific
requirements for the enterprise SIP-enabled solution. For Claro, this profile was left with the avaya-
ru default values.

On the left navigation pane, select Global Profiles & Server Interworking (not shown). From the
Interworking Profiles list, select avaya-ru. Click Clone on top right of the screen (not shown).

Enter the new profile name in the Clone Name field, the name of Avaya-1PO was chosen in this
example. Click Finish.

Clone Profile X

Profile Name avaya-ru
|Clone Name Avaya-lPO |
Finish
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Click Edit on the newly cloned Avaya-1PO interworking profile:
On the General tab, check T.38 Support.
Leave remaining fields with default values.

HG; Reviewed:
SPOC 8/20/2018

Click Finish.

Editing Profile: Avaya-IPO X

General

(L) RFC2543 - ¢=0.0.0.0

Hold Support
() RFC3264 - a=sendonly

130 Handling ® None O SDP ) No SDP
181 Handling ® None O SDP ) No SDP
182 Handling ® None O SDP () No SDP
183 Handling ® None O SDP O No SDP
Refer Handling O

URI Group Nane v

Send Hold

Delayed Offer
3xx Handling O

Diversion Header Support
Delayed SDP Handling |
Re-Invite Handling |
Prack Handling |

Allow 18X SDP
T.38 Support |
URI Scheme ® 3p OTEL O ANY

Via Header Format

® RFC3261
O RFC2543
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The following screen capture shows the General tab of the newly created Avaya-1PO Server
Interworking Profile.

Alarms  Incidents  Status~ Logs~  Diagnostics Users

Session Border Controller for Enterprise
Dashboard Interworking Profiles: Avaya-IPO
Administration Add
Backup/Restore
Interworking Profiles Click here to add a description.
System Management
cs2100
> Global Parameters General ||| Timers || Privacy | | URI Manipulation || Header Manipulation | | Advanced |
4| Global Profiles avaya-ru
] General
Domain DoS 0CS-Edge-Server
Server Interworking : Hold Support NONE
cisco-ccm
Media Forking 180 Handling None
. cups
Routing 181 Handling None
Server Configuration OCS-FrontEnd-Server )
o 1682 Handling None
Topology Hiding Avaya-SM
Signaling Manipulation 183 Handling None
g 9 P SP-General Refor Handii N
URI Groups eter Nandling o
Avaya-IPO
SNMP Traps URI Group None
Time of Day Rules Avaya-C31000 Send Hold No
FGDN Groups Avaya-CM
) Delayed Offer No
Reverse Proxy Policy
RADIUS 3xx Handling No
> PPM Services Diversion Header Support No
> Domain Policies Delayed SDP Handling No
> TLS Management Re-Invite Handling No
> Device Specific Settings
Prack Handling No
Allow 18X SDP No
T.38 Support Yes
URI Scheme SIP
Via Header Format RFC3261
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The following screen capture shows the Advanced tab of the newly created Avaya-1PO Server
Interworking Profile.

Alarms  Incidents  Status~ Logs~  Diagnostics  Users

Session Border Controller for Enterprise
Dashboard Interworking Profiles: Avaya-IPO
Administration Add
Backup/Restore
Interworking Profiles Click here to add a descnption.
System Management
cs2100
> Global Parameters General || Timers || Privacy ‘ | URI Manipulation || Header Manipulation || Advanced |
4 |Global Profiles avaya-ru
Domain DoS OCS-Edge-Senver Record Routes Both Sides
Server Interworking . Include End Point IP for Context Lookup Yes
- " cisco-ccm
Media Forking Extensions Avaya
. cups
Routing Diversion Manipulation No
version anipula
Server Configuration OCS-FrontEnd-Server
. Has Remote SBC Yes
Topology Hiding Avaya-SM
i i i i Route Response on Via Port No
Signaling Manipulation Sp-General pol
URI Groups Relay INVITE Replace for SIPREC No
Avaya PO
SNMP Traps MOBX R -
e-INVITE Handling No
Time of Day Rules Avaya-C31000
FGDN Groups Avaya-CM DTMF
Reverse Proxy Policy DTMF Support None
RADIUS
; Edit
> PPM Services
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6.3.2 Server Interworking - SP-General
A second Server Interworking profile named SP-General was created for the Service Provider.

On the left navigation pane, select Global Profiles - Server Interworking (not shown). From the
Interworking Profiles list, select Add (not shown) (note that Add is being used to create the SP-
General profile instead of cloning the avaya-ru profile).

Enter the new profile name, the name of SP-General was chosen in this example.
e Click Next.

Interworking Profile

| Profile Name SP-General |
Next
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 42 of 87

SPOC 8/20/2018 ©2018 Avaya Inc. All Rights Reserved. ClarolPO11SBC72



On the General tab, check T.38 Support. Click Next, and then click Finish on the last tab leaving
remaining fields with default values (not shown).

Interworking Profile X

General

® None

Hold Support :' RFC2543 - ¢=0.0.0.0
L) RFC3264 - a=sendonly

180 Handling ® None O SDP O No SDP
181 Handling ® None O SDP O No SDP
182 Handling ® None O SDP O No SDP
183 Handling ® None O SDP O No SDP
Refer Handling |

URI Group Nane v

Send Hold v

Delayed Offer v
3xx Handling (|

Diversion Header Support

Delayed SDP Handling |
Re-Invite Handling O
Prack Handling [l
Allow 18X SDP
T.38 Support
URI Scheme ®sp O TEL O ANY
® RFC3261

Via Header Format
[ RFC2543
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The following screen capture shows the General tab of the newly created SP-General Server
Interworking Profile.

Alarms  Incidents  Status~ Logs~  Diagnostics Users

Session Border Controller for Enterprise
Dashboard Interworking Profiles: SP-General
Administration Add
Backup/Restore
Interworking Profiles Click here to add'a description.
System Management
cs2100
> Global Parameters General ” Timers H Privacy || URI Manipulation || Header Manipulation | | Advanced |
4 |Global Profiles avaya-fu
General
Domain Dos 0CS-Edge-Server e ——
Server Interworking ) Hold Support NONE
cisco-ccm
Media Forking 180 Handling None
. cups
Routing 181 Handling None
Server Configuration OCS-FrontEnd-Server )
o 182 Handling None
Topology Hiding Avaya-SM
Signaling Manipulation 183 Handiing None
SP-General
URI Groups Refer Handling No
Avaya-IPO
SNMP Traps y URI Group None
Time of Day Rules Avaya-C51000 Send Hold No
FGDN Groups Avaya-CM
. Delayed Offer No
Reverse Proxy Policy
RADIUS 3xx Handling No
> PPM Services Diversion Header Support No
> Domain Policies Delayed SDP Handling No
> TLS Management Re-Invite Handling No
> Device Specific Settings
Prack Handling No
Allow 18X SDP No
T.38 Support Yesl
URI Scheme SIP
Via Header Format RFC3261
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The following screen capture shows the Advanced tab of the newly created SP-General Server

Interworking Profile.

Alatmms  Incidents

Status ~

Logs ~  Diagnostics

Users

Dashboard
Administration
Backup/Restore
System Management
> (Global Parameters

4| Global Profiles

Domain DoS
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups
Reverse Proxy Policy
RADIUS

> PPM Services

Session Border Controller for Enterprise

Interworking Profiles: SP-General
Add

Interworking Profiles Click here to add'a description.

cs2100

avaya-fu
0CS-Edge-Server
cisco-ccm

cups
OCS-FrontEnd-Server
Avaya-SM

Avaya-IPO
Avaya-CS1000

Avaya-CM

General || Timers H Privacy || URI Manipulation || Header Manipulation | | Advanced L

Record Routes Both Sides
Include End Point IP for Context Lookup No
Extensions MNone
Diversion Manipulation No

Has Remote SBC Yes

Route Response on Via Port No

Relay INVITE Replace for SIPREC No

MOBX Re-INVITE Handling No

DTMF Support None
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6.3.3 Signaling Manipulation

The Signaling Manipulation feature of the Avaya SBCE allows an administrator to perform granular
header manipulations on the headers of the SIP messages, which sometimes is not possible by direct
configuration on the web interface. This ability to configure header manipulation in such a highly
flexible manner is achieved by the use of a proprietary scripting language called SigMa.

The script can be created externally as a regular text file and imported in the Signaling Manipulation
screen, or they can be written directly in the page using the embedded Sigma Editor. In the reference
configuration, the Editor was used. A detailed description of the structure of the SigMa scripting
language and details on its use is beyond the scope of these Application Notes. Consult reference
[10] in the References section for more information on this topic.

A Sigma script was created during the compliance test to correct the following interoperability issues
(refer to Section 2.2):
e Calls from IP Office to the PSTN with “privacy” enabled do not include the privacy header
(privacy = id) in the INVITE message sent to Claro.

The scripts will later be applied to the Server Configuration profiles corresponding to the service
provider in Section 6.3.4.

To create the SigMa script to set the privacy header (privacy = id) in the INVITE message sent to
Claro, on the left navigation pane, select Global Profiles = Signaling Manipulation. From the
Signaling Manipulation Scripts list, select Add.

e For Title enter a name, the name Add_Privacy Header was chosen in this example.

e Copy the complete script from Appendix A.

e Click Save.
Signaling Manipulation Editor AVAYA
Title [Add_Privacy_Header |
1 within session "INVIIE"
? -a:: on message where FDIRECTION="QUTEQUND" and %ENTRY POINT="PO3T ROUTING"
; ff:fix ANonymous
5 if (#HEADERS["From"] [1] .URI.USER = "anonymous") then
if (exists (¥HEADERS["Priwvacy™] [1] then
%3do = "nothing";
else
$HEADERS ["Privacy™] [1] = "id";
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 46 of 87

SPOC 8/20/2018 ©2018 Avaya Inc. All Rights Reserved. ClarolPO11SBC72



6.3.4 Server Configuration

Server Profiles should be created for the Avaya SBCE’s two peers, the Call Server (IP Office) and
the Trunk Server or SIP Proxy at the service provider’s network.

To add the profile for the Call Server, from the Global Profiles menu on the left-hand navigation
pane, select Server Configuration (not shown). Click Add Profile (not shown) and enter the profile
name: IP Office.

e Click Next.

Add Server Configuration Profile

Profile Name IP Office |

Next

On the Add Server Configuration Profile window:
e Server Type: Select Call Server.
e IP Address/FQDN: 192.168.128.167 (IP Address of IP Office).
e Port: 5061 (This port must match the port number defined in Section 5.2.1).
e Transport: Select TLS.
e Selecta TLS Client Profile.

o Click Next.

|Sen.ferType |Ca|l Server | V|

SIP Domain | |

DNS Query Type NONE/A v

|TLS Client Profile |RemoleWorkersCIientF‘rofile v ||

Add

IP Address / FQDN Port Transport

||192.168.]28.16?‘ | [5061 | 5| V| Delete

e Click Next on the Add Server Configuration Profile - Authentication window (not
shown).

e Click Next on the Add Server Configuration Profile - Heartbeat window (not shown).

e Click Next on the Add Server Configuration Profile - Registration window (not shown).

e Click Next on the Add Server Configuration Profile - Ping window (not shown).
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On the Add Server Configuration Profile - Advanced tab:
e Select Avaya-1PO from the Interworking Profile drop down menu (Section 6.3.1).

e Leave the Signaling Manipulation Script at the default None.
e Click Finish.

Add Server Configuration Profile - Advanced X

Enable DoS Protection O
Enable Grooming |
Interworking Profile [Avaya-IPO v |
Signaling Manipulation Script |N0ne V|
Securable O
Enable FGDN O
TCP Failover Port 5060
TLS Failover Port 5061
Tolerant O
URI Group

The following screen capture shows the General tab of the newly created IP Office Server
Configuration Profile.

Alarms  Incidents Status~ Logs~ Diagnostics Users

Settings v

Help v  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard
Administration
Backup/Restore
System Management
Global Parameters

4 |Global Profiles

Domain DoS

Server Configuration: IP Office

Add

Server Profiles

General ” Authentication U Heartbeat U Registration H Ping H Advanced }

| Rename H Cleone H Delete |

CS1000

Server Type
Com Manager

TLS Client Profile

Call Server

RemoteWorkersClientProfile

SP-5C

Server Interworking DNS Query Type NONE/A
. K Service Provider ...
Media Forking ! IP Address / FQDN Port Transport
Routing Session Manager
[192.168.128.167 5061 TLS |

Server Configuration IP Office

Topology Hiding Service Provider...

Signaling Manipulation

URI Groups
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The following screen capture shows the Advanced tab of the newly created IP Office Server
Configuration Profile.

Alarms  Incidents  Statlus~ Logs v  Diagnostics Users Settings v Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard ~ Server Configuration: IP Office
Administration Add ‘ Rename || Clone H Delete |
Backup/Restore
System Management General U Authentication u Heartbeat U Registration U Ping U Advanced |
Global Parameters Gs1000 .
Enable DoS Protection O

4 | Global Profiles Com Manager

Domain DoS SP.SC Enable Grooming O

Server mler-wmk‘ng Service Provide. . Interworking Profile Avaya-IPO |

Media Forking Session Manager Signaling Manipulation Script None

Routing

Configuration Service Provide... Enable FGDN O

Topology Hiding

Signaling Tolerant U

Manipulation URI Group None

URI Groups

SNMP Traps

Time of Day Rules

To add the profile for the Trunk Server, from the Server Configuration screen, click Add in the
Server Profiles (not shown) section and enter the profile name: Service Provider UDP.

e Click Next.

Add Server Configuration Profile

Profile Name vice Provider UDP

Next
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On the Add Server Configuration Profile window:
e Server Type: Select Trunk Server.

e IP Address/FQDN: 172.31.21.1 (IP Address of the Service Provider SIP Proxy).

e Port: 5060.
e Transports: Select UDP.
o Click Next.

Edit Server Configuration Profile - General X

Add

V\ Delete

| Server Type |Trunk Server v ||
SIP Domain | |
DNS Query Type

TLS Client Profile None

IP Address / FQDN Port Transport
||172_31_21_1 | [5060 | [uoP |

e Click Next on the Add Server Configuration Profile - Authentication window (not

shown).

e Click Next on the Add Server Configuration Profile - Heartbeat window (not shown).
e Click Next on the Add Server Configuration Profile - Registration window (not shown).
e Click Next on the Add Server Configuration Profile - Ping window (not shown).
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In the Add Server Configuration Profile - Advanced window:
e Select SP-General from the Interworking Profile (Section 6.3.2).

e Select Add_Privacy_Header from the Signaling Manipulation Script (Section 6.3.3)
e Click Finish.

Add Server Configuration Profile - Advanced X

Enable DoS Protection O
Enable Grooming v
Interworking Profile [SP-General v
Signaling Manipulation Script |Add7Privacy7Header V|
Securable O
Enable FGDN Il

TCF Failover Port 5060

TLS Failover Port 5061
Tolerant O
URI Group

| Back | | Finish |

The following screen capture shows the General tab of the newly created Service Provider UDP
Server Configuration Profile.

Alarms  Incidents  Status~ Logsv  Diagnostics Users Settings v Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard ~ Server Configuration: Service Provider UDP
Administration Add ‘ Rename || Clone H Delete |
Backup/Restore
System Management General ” Authentication u Heartbeat U Registration U Ping U Advanced ‘
CS1000
Global Parameters Server Type Trunk Server
4 |Global Profiles Com Manager
- DNS Query Type NONE/A

Domain DoS SP-SC

Server Inler\Nork\ng Service Provide. IP Address / FQDN Port Transport

Media Forking ) [17231.211 5060 uDP|

Routing Session Manager

Configuration

Topology Hiding
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The following screen capture shows the Advanced tab of the newly created Service Provider UDP
Server Configuration Profile.

Alarms  Incidents  Status~v Logs v  Diagnostics  Users Settings v Help ~  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard A~ Server Configuration: Service Provider UDP
Administration Add ‘ Rename || Clone || Delete |
Backup/Restore
Server Profiles icati i i i
System Management _ General H Authentication H Heartbeat “ Registration ” Ping H Advanced |
Global Parameters 51000 .
Enable DoS Protection O

4 [Global Profiles Com Manager

Domain DoS sp.sc Enable Grooming il

Server |nlef-W0fk‘”Q Service Provide. . Interworking Profile SP-General

Med‘.a Forking Session Manager Signaling Manipulation Script Add_Privacy_Header

Routing

Securable O

Configuration Enable FGDN OJ

Topology Hiding

Signaling Tolerant =
Manipulation URI Group None
URI Groups -
SNMP Traps
Time of Day Rules N
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6.3.5 Routing Profiles

Routing profiles define a specific set of routing criteria that are used, in conjunction with other types
of domain policies, to determine the route that SIP packets should follow to arrive at their intended
destination.

Two Routing profiles were created, one for inbound calls, with IP Office as the destination, and the
second one for outbound calls, which are sent to the Service Provider SIP trunk.

To create the inbound route, from the Global Profiles menu on the left-hand side (not shown):
e Select Routing (not shown).
e Click Add in the Routing Profiles section (not shown).
e Enter Profile Name: Route_to IPO_TLS.
e Click Next.

Routing Profile

|Proﬂle Name Route_ta_IPO_I x |

Next

On the Routing Profile screen complete the following:
e Click on the Add button to add a Next-Hop Address.
e Priority / Weight: 1
e Server Configuration: Select IP Office.

e Next Hop Address is populated automatically with 192.168.128.167:5061 (TLS) (IP Office
IP address, Port and Transport).

e Click Finish.
URI Group Time of Day
Lead Balancing | Priority ~v|  NAPTR
Transport None v Next Hop Priority 1
MNext Hop In-Dialog [] Ignore Route Header  []
ENUM O ENUM Suffix

Priority /
Weight

Server Configuration  Next Hop Address Transport

||1 | [IP Office w| [192.168.128.167:5061 (TLS) v|| None “| Delete
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The following screen shows the newly created Route_to IPO_TLS Routing Profile.

Alaftms 3 Incidents  Status~  Logs~  Diagnostics  Users Setlings Help ~ Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles:|Ro ute_lo_IF’O_TLS|
Administration

Add ‘ Rename H Clone || Delete |
Backup/Restore

Routing Profiles Click here to add a descripfion.
System Management ick-here to add a description

> Global Parameters G m‘
e Route_to_SM
Domain DoS Route_to_CM ik
Server Interworking Route to IPO U.. Priority gfﬂup 'g::e i Load Balancing Next Hop Address Transport
Media Forking -
To SMfrom Rem... | . default Priority 192.168.128.167 TLS| Edit Delete
Server Configuration To IPO from Re...
Topology Hiding
Signaling Manipulation

Route to SP_TLS

URI Groups

Similarly, for the outbound route:
e Select Routing (not shown).
e Click Add in the Routing Profiles section (not shown).
e Enter Profile Name: Route_to SP_UDP.
e Click Next.

Routing Profile

Profile Name ite_to_SP_UDP| x

Next
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On the Routing Profile screen complete the following:
e Click on the Add button to add a Next-Hop Address.
e Priority / Weight: 1
e Server Configuration: Select Service Provider UDP.

e Next Hop Address is populated automatically with 172.31.21.1:5060 (UDP) (Service
Provider SIP Proxy IP address, Port and Transport).

e Click Finish.

Routing Profile X

URI Group Time of Day
Load Balancing [ Priority v|  NAPTR

Transport None WV Next Hop Priority ]

Next Hop In-Dialog [ Ignore Route Header [ ]

ENUM O ENUM Suffix

Add

Priority /

Server Configuration  Next Hop Address Transport

Weight

[ | [Service Provider | [172.31.21.15060 (UDP)

V|| None | Delete

The following screen capture shows the newly created Route_to_SP_UDP Routing Profile.

Alarms  Incidents  Status v Users

Logs v

Diagnostics Settings v Help v  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard
Administration
Backup/Restore

System Management

Routing Profiles: Route_to_SP_UDP

Add

Routing Profiles Click here to add a description:

‘ Rename H Clone H Delete ‘

Global Parameters Sl Routing Profile
+ [Gioba Prafies | Raut o SW
Domain DoS Route_to_CM L
Server Interworking Route to IPO Priority glr:gup —g;:fe = Load Balancing Next Hop Address Transport
Media Forking - T .
TSR | - default  Priority 172.31.21.1 UDP| Edit Delete
Server To IPO from Re...
Configuration Route_to IPO_...
Topology Hiding S
5 . Route_to_SP_T...

Signaling
Manipulation Route_to_CS51000
SNMP Traps
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6.3.6 Topology Hiding

Topology Hiding is a security feature which allows changing several parameters of the SIP packets,
preventing private enterprise network information from being propagated to the untrusted public
network.

Topology Hiding can also be used as an interoperability tool to adapt the host portion in SIP headers
like To, From, Request-URI, Via, Record-Route and SDP to the IP addresses or domains expected
by IP Office and the SIP trunk service provider, allowing the call to be accepted in each case.

For the compliance test, only the minimum configuration required to achieve interoperability on the
SIP trunk was performed. Additional steps can be taken in this section to further mask the
information that is sent from the Enterprise to the public network.

To add the Topology Hiding Profile in the Enterprise direction, select Topology Hiding from the
Global Profiles menu on the left-hand side (not shown):

e Click on default profile and select Clone Profile (not shown).
e Enter the Profile Name: IP Office.
e Click Finish.

Clone Profile X

Profile Name default
|Clone Name IP Office |

The following screen capture shows the newly added IP Office Topology Hiding Profile. Note that
for IP Office no values were overwritten (left with default values).

Alarms 3 Incidents  Status~  Logs~  Diagnostics  Users Settings Help ~  Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: IP Office
Backup/Restore
Topelogy

Systern Management Click here to add a descripfion.
> Global Parameters default Topology Hiding
4| Global Profiles .

Domain DoS cisco_th_profile Replace Action Overwrite Value

Server Interworking Session_Manager Refer-To IP/Domain Auto

Media Forking Service_Provider Referred-By IP/Domain Auto

Routing Com Manager Record-Route IP/Domain Auto

Server Configuration

T . Hiding CS1000 Request-Line IP/Domain Auto

opology

Signaling Manipulation IP Office To IP/Domain Auto

URI Groups From IP/Domain Auto

SNMP Traps SDP IP/Domain Auto

Time of Day Rules Via IP/Domain Auto

FGDN Groups

Reverse Proxy Policy

RADIUS
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To add the Topology Hiding Profile in the Service Provider direction, select Topology Hiding from
the Global Profiles menu on the left-hand side (not shown):
e Click on default profile and select Clone Profile (not shown).

e Enter the Profile Name: Service_Provider.

e Click Finish.
Clone Profile X
Profile Name default
|Clone Name Service_Provider |

e Click Edit on the newly created Service_Provider Topology Hiding profile.

e On the From choose Overwrite from the pull-down menu under Replace Action, enter the
domain name for the service provider (ims.claro.com.do) under Overwrite Value.

e On the Request-Line choose Overwrite from the pull-down menu under Replace Action;
enter the domain name for the service provider (ims.claro.com.do) under Overwrite Value.

e On the To choose Overwrite from the pull-down menu under Replace Action, enter the
domain name for the service provider (ims.claro.com.do) under Overwrite Value.

e Click Finish.

Edit Topology Hiding Profile X

Header Critenia Replace Action Overwrite Value
[sDP ~| [IP/Domain ¥| [Auto v Delete
|Rec>ord—Route V| \IP}'Doma\n V| |Auto V| Delete
[Refer-To v| [IP/Domain V| [Auto v Delete
||From V| \IP}'Doma\n V| |Overwrite V| |ims.clam.com.do ‘l Delete
|Referred—By V| \IP}'Doma\n V| |Auto V| Delete
[via v| [IPDomain V] [Auto v Delete
|Request-Line V| \IP}'Doma\n V| |Overwrite V| |ims.clam.com.do ‘ Delete
[To v| [IP/Domain v [Qverwrite v [ims.claro.comdo || Delete
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The following screen capture shows the newly added Service_Provider Topology Hiding Profile.

Alarms  Incidents Status~ Logs~ Diagnostics Users Settings ~ Help ~  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Topology Hiding Profiles: Service_Provider
Administration

Add | Rename H Clone H Delete |
Backup/Restore

Topology Hiding Click here to add a description.
System Management Profiles

Global Parameters default Topology Hiding

4 |Global Profiles
Domain DoS cisco_th_profile Header Criteria Replace Action Ovenwrite Value
Server Interworking Session_Manager SDP IP/Domain Auto
Media Forking Record-Route IP/Domain Auto
Routing Com Manager Refer-To |P/Domain Auto
Server Configuration - -

Cs1000 |From IP/Domain Overwrite ims_claro_com.do

Topology Hiding
Signaling Manipulation IP Office Referred-By IP/Domain Auto
URI Groups Via IP/Domain Auto
SNMP Traps Request-Line IP/Domain Overwrite ims.claro.com.do
Time of Day Rules To IP/Domain Overwrite ims claro_com.do
FGDN Groups
Reverse Proxy Paolicy
RADIUS
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6.4 Domain Policies

Domain Policies allow configuring, managing and applying various sets of rules designed to control
and normalize the behavior of call flows, based upon various criteria of communication sessions
originating from or terminating in the enterprise.

6.4.1 Application Rules

Application Rules defines which types of SIP-based Unified Communications (UC) applications the
Avaya SBCE will protect: voice, video, and/or Instant Messaging (IM). In addition, Application
Rules defines the maximum number of concurrent voice and video sessions the network will process
in order to prevent resource exhaustion.

From the menu on the left-hand side, select Domain Policies = Application Rules (not shown).
e Click on the Add button to add a new rule (not shown).
e Rule Name: enter the name of the profile, e.g., 500 Session.

e Click Next.

Application Rule

e Under Audio check In and Out and set the Maximum Concurrent Sessions and Maximum

Rule Name 500 Session

Next

Sessions Per Endpoint to recommended values; the value of 500 was used in the sample

configuration.
e Click Finish.

HG; Reviewed:
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P Maximum Maximum Sessions
Application Type In"Out concurrent Sessions  Per Endpoint
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The following screen capture shows the newly created 500 Sessions Application Rule.

Alatms 3 Incidents  Status~  Logs~  Diagnostics  Users Settings ~ Help v~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: 500 Sessions

Administration

Add ‘Fllter By Device | | Rename H Clone || Delete |
Backup/Restore

System Management Application Rules Click here to add/a description.
» Global Parameters etanit Application Rule

> Global Profiles default-trunk
— Maximum Concurrent Maximum Sessions Per
» PPM Services default-subscribe... Appiication Type I Out g2l Endpomt s
P - —
Domain .Polllmes default-subscribe. .. |Audig ¥ & 500 500 |
Application Rules
Border Rules default-server-low Video O 0O
Media Rules default-server-high
Signaling Rules CDR Support Off
500 Sessions
End Point Policy RTCP Keep-Alive No
Groups Remote-Workers
Session Palicies
> TLS Management
> Device Specific Settings
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6.4.2 Media Rules

Media Rules allow one to define RTP media packet parameters such as prioritizing encryption
techniques and packet encryption techniques. Together these media-related parameters define a strict
profile that is associated with other SIP-specific policies to determine how media packets matching
these criteria will be handled by the Avaya SBCE security product. For the compliance test, two
media rules (shown below) were used; one toward IP Office and one toward the Service Provider.

To add a media rule in the IP Office direction, from the menu on the left-hand side, select Domain
Policies 2 Media Rules.

e Click on the Add button to add a new media rule (not shown).

e Under Rule Name enter IPO_SRTP.

e Click Next.
Media Rule
[ Name [Fosmir_«]
MNext
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e Under Audio Encryption, Preferred Format #1, select
SRTP_AES _CM_128 HMAC_SHA1_80.

e Under Audio Encryption, Preferred Format #2, select RTP.

e Under Audio Encryption, uncheck Encrypted RTCP.

e Under Audio Encryption, check Interworking.

Repeat the above steps under Video Encryption.

Under Miscellaneous check Capability Negotiation.

Click Next.

Media Rule X

Audio Encryption
Preferred Format #1 [SRTP_AES_CM_128_HMAC_SHA1_80 V]|
Preferred Format #2 [RTP v
Preferred Format #3 [NONE M
Encrypted RTCP 0|
MKI O
Lifetime
Leave blank to match any value. 2n I:I

| Interworking |

Video Encryption
Preferred Format #1 |SRTP_AES_CM _123_HMAC_SHA1_80 V|
Preferred Format #2 [RTP M
Preferred Format #3 [NONE V]
Encrypted RTCP 0O |
MKI1 O
Lifetime
Leave blank to match any value. 2 I:I

| Interworking [~ |

Miscellaneous

|Capabi|ity Negotiation |

e Accept default values in the remaining sections by clicking Next (not shown), and then click
Finish (not shown).
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The following screen capture shows the newly created IPO_SRTP Media Rule

Alarms  Incidents

Logs ~  Diagnostics

Users Settings ~ Help ~ Log Out

Session Border Controller for Enterprise

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
> Global Profiles

> PPM Services

4| Domain Policies

AVAYA

Media Rules: IPO_SRTP

Add

[Filter By Device... v

‘ Rename H Clone H Delete |

Media Rules Click here to add a description.

default-low-med
default-low-med-enc
default-high

default-high-enc

Encryption ” | Codec Prioritization | | Advanced ‘ QoS

Audio Encryption

Preferred Formats ?{?;P_AES_CM_128_HMAC_5HA1_ED

Application Rules

Border Rules avaya-low-med-enc Encrypted RTCP 0
Media Rules Rem_Workers_SRTP MKI O

Security Rules

Lifetime Any

Signaling Rules ServiceProvider SRTP

End Point Policy

| Interworking [} |

Groups SM_SRTP
Session Policies Sl E R
- TLS Management Preferred Formats SRTP_AES_CM_128_HMAC_SHAT 20
» Device Specific Settings
Encrypted RTCP O
MKI O
Lifetime Any
|Inlarworking M |
Miscellaneous
| Capability Negotiation vl |

For the media rule in the Service Provider direction, the existing/predefined media rule default-low-
med was used.
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6.4.3 End Point Policy Groups

End Point Policy Groups are associations of different sets of rules (Media, Signaling, Security, etc.)
to be applied to specific SIP messages traversing through the Avaya SBCE.

To create an End Point Policy Group for the Enterprise, from the Domain Policies menu, select End
Point Policy Groups (not shown).

e Click on the Add button to add a new policy group (not shown).

e Group Name: IPO SRTP.
Click Next.

Policy Group

Group Name IPO SRTP
| lPosre |

Next

e Application Rule: 500 Sessions.

e Border Rule: default.

e Media Rule: IPO_SRTP (Section 6.4.2).
e Security Rule: default-low.

e Signaling Rule: default.

e Click Finish.

Application Rule |5DU Sessions V|
Border Rule |defau|t V|
Media Rule [IPO_SRTP v|
Security Rule default-low Vv
Signaling Rule |defau|t V|
Charging Rule
RTCP Monitoring Report Generation Off hd
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The following screen capture shows the newly created IPO SRTP End Point Policy Group.

Alarms  Incidents  Status~ Logs~ Diagnostics Users Settings v Help ~  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard "
Policy Groups Click here to add a description. A

Administration

defauli-low ) ,,
Backup/Restore Hover over a row to see its description.

default-low-enc

System Management "
Policy Group
Global Parameters defauli-med
Global Profiles default-med-enc
PPM Services .
default-high Ord Application  Bord Med Securi Signal Ch,
4 rder pplication Jorder viedia ¥e<,.um:y' Signaiing (-harging
Application Rules default-high-enc =0
Border Rules OCS-default-high | 1 Sessions default IPO_SRTP  default-low  default None Off| Edit
Media Rules avaya-def-low-enc

Security Rules avaya-def-high-_

Signaling Rules

-def-high-_.
Charging Rules avaya-derhig

End Point Policy Enterprise
Groups Service Provider

Session Policies
Rem Workers In._.
TLS Management

Device Specific Settings Rem Workers S...

Rem Workers R._.

’
Similarly, to create an End Point Policy Group for the Service Provider SIP Trunk.

e Click on the Add button to add a new policy group (not shown).

e Group Name: Service Provider.

e Click Next.

Policy Group
Group Name Service Provider |
Next
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e Application Rule: 500 Sessions.
e Border Rule: default.

e Media Rule: default-low-med.

e Security Rule: default-low.

e Signaling Rule: default.

e Click Finish.

Policy Group X

Application Rule |500 Sessions V|
Border Rule [default v

Media Rule [default-low-med v
Security Rule

Signaling Rule |default hd
Charging Rule

RTCP Monitoring Report Generation Off v

The following screen capture shows the newly created Service Provider End Point Policy Group.

Alarms  Incidents  Status~ Logs~  Diagnostics  Users Settings v Help ~  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Policy Groups: Service Provider
Administration

~

Add |F|Iter By Device... V\ ‘ Rename H Clone H Delete |
Backup/Restore

Policy Groups Glick here to add a descripfion.
System Management
default-low
Global Parameters Hover over a row to see its description.

Global Profiles default-low-enc

PPM Services ernimed m‘

4
W default-med-enc
Application Rules
Border Rules default-high Order Application  Border Security Signaling Charging
Media Rules default-high-enc
Security Rules 0OCS-default-high ||Z| gjeusswons default ggzu\t-lnw- default-low  default None off Edit
Signaling Rules avaya-det-low-enc
Charging Rules
_ — avaya-def-high-..
End Point Policy
Groups avaya-def-high-..
Session Policies Enterprise
TLS Management
Device Specific Settings
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6.5 Device Specific Settings

The Device Specific Settings allow the management of various device-specific parameters, which
determine how a particular device will function when deployed in the network. Specific server
parameters, like network and interface settings, as well as call flows, etc. are defined here.

6.5.1 Network Management

The network information should have been previously completed. To verify the network
configuration, from the Device Specific Settings on the left hand side, select Network
Management. Select the Networks tab.

In the event that changes need to be made to the network configuration information, they can be
entered here.

Use Figure 1 as reference for IP address assignments.

Note: Only the highlighted entity items were created for the compliance test, and are the ones
relevant to these Application Notes. Blurred out items are part of the Remote Worker configuration,
which is not discussed in these Application Notes.

Alarms  Incidents Status~ Logs~ Diagnostics Users Settings v Help v  Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Network Management: Avaya_SBCE
Administration
Backup/Restore
System Management jfertacesy | Networks
Global Parameters Avaya_SBCE Add
Global Profiles ]
PPM Services Name Gateway Prefix Length Interface IP Address
Domain Policies 10.64.101.159,
TLS Management Network_A1 10.64.101.53 255.255.255.0 Al 10.64.101 243,| Edit Delete
4 | Device Specific Setlings
Network Edit Delete
Management
Media Interface
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On the Interface Configuration tab, click the Toggle control for interfaces Al to change the status to
Enabled. It should be noted that the default state for all interfaces is disabled, so it is important to
perform this step or the Avaya SBCE will not be able to communicate on any of its interfaces.

Alarms  Incidents Status~ Logs~ Diagnostics Users Settings ~ Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Network Management: Avaya_SBCE
Administration
Backup/Restore ‘
D
System Management Interfaces | Networks
Global Parameters Avaya_SBCE
Global Profiles
Interface Name VLAN Tag Status
PPM Services
i i [A1 Enabled|
Domain Policies
TLS Management A2 Disabled
4| Device Specific Settings B1 Enabled
Network B2 Disabled
Management

Media Interface
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6.5.2 Media Interface

Media Interfaces were created to adjust the port range assigned to media streams leaving the
interfaces of the Avaya SBCE. On the Private and Public interfaces of the Avaya SBCE, the port
range 35000 to 40000 was used.

From the Device Specific Settings menu on the left-hand side, select Media Interface (not shown).
e Select Add in the Media Interface area (not shown).
e Name: Private_med.
e Under IP Address select: Network Al (A1, VLAN 0)
e Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBCE, toward IP Office).
e Port Range: 35000-40000.

e Click Finish.
Name | Private_med |
[Netwark_A1 (A1, VLAND) V|
IP Address

e Select Add in the Media Interface area (not shown).
e Name: Public_med.
e Under IP Address select: Network Al (A1, VLAN 0)

e Select IP Address: 10.64.101.159 (Outside IP Address of the Avaya SBCE, toward the
Service Provider).

e Port Range: 35000-40000.
e Click Finish.

Add Media Interface X

Name ‘Public_med |

[Network_A1 (A1, VLAND) V|

IP Address
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The following screen capture shows the newly created Media Interfaces.

Alarms  Incidents

Status v~

Logs~ Diagnostics Users

Settings v Help ~

Log Out

Dashboard
Administration

Session Border Controller for Enterprise

Media Interface: Avaya_SBCE

AVAYA

Backup/Restore
D N
System Management Media Interface
Global Parameters Avaya_SBCE
IModifying or deleting an existing media interface will require an application restart before taking effect. Application
Global Profiles restarts can be issued from System Management.
PPM Services
Add
Domain Policies
TLS Management Name Ll Port Range
4 |Device Specific Setti
Svice Spectlic Setings [Prvate_med Nehwat o e vLaN & 35000 - 40000 | Fdit Delete
Network Management = .
Media Interface Edit Delete
Signaling Interface
End Point Flows Edit - Delete
Session Flows Public_med . 35000 - 40000 Edit Delete
DMZ Services ——
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6.5.3 Signaling Interface
To create the Signaling Interface toward IP Office, from the Device Specific menu on the left hand
side, select Signaling Interface (not shown).
e Select Add in the Signaling Interface area (not shown).
e Name: Private_sig.
e Under IP Address select: Network Al (A1, VLAN 0)
e Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBCE, toward IP Office).
e TLS Port: 5061.
e Selecta TLS Profile.

e Click Finish.
Add Signaling Interface X
Name | Private_sig |
[Network_A1 (A1.VLAND) |
IP Address
10.64.101.243 W

TCP Port | |
Leave blank to disable
UDP Port | |
Leave blank to disable
TLS Port
Leave bEank to disable |506-I |

TLS Profile [NewRemoteWorkerServerProfile |

Enable Shared Control O

Shared Control Port
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e Select Add in the Signaling Interface area (not shown).
e Name: Public_sig.
e Under IP Address select: Network Al (A1, VLAN 0)

e Select IP Address: 10.64.101.159 (outside or public IP Address of the Avaya SBCE, toward

the Service Provider).
e UDP Port: 5060.
e Click Finish.

Add Signaling Interface X

Name |Public_sig |
[Network_A1({A1,VLAND) V|
IP Address
10.64.101.159 b4
TCP Port | |
Leave blank to disable
UDP Port
Leave blank to disable |5060 |
TLS Port | |
Leave blank to disable
TLS Profile None v

Enable Shared Control

Shared Control Port

The following screen capture shows the newly created Signaling Interfaces.

Alarms  Incidents  Status v Users

Logs v

Diagnostics
Session Border Controller for Enterprise

Dashboard
Administration

Signaling Interface: Avaya_SBCE

Backup/Restore

System Management
Global Parameters
Global Profiles
PPM Services
Domain Policies
TLS Management

4| Device Specific Settings

Devices

Signaling Interface

Settings v Help ~  Log Out

AVAYA

Avaya_SBCE

Application restarts can be issued from System Management.

TCP
Port

UDP TLS
Port  Port

Signaling IP
Network

IModifying or deleting an existing signaling interface will require an application restart before taking effect.

TLS Profile

) 10.64.101.243 )

Network Management Private_sig \N/etwurkrA1 (A1, 5061 NewRemoteWorkerServerProfile | Edit  Delete

Media Interface

End Point Flows

Session Flows Edit Delete

DMZ Services
. ) 10.64.101.159
TURN/STUN Service Public_sig Network_A1 (A1, 5060 — None Edit Delete
VLAN 0

SNMP
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6.5.4 End Point Flows

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URIs, etc.) is
used to determine which flow it matches. Once the flow is determined, the flow points to a policy
group which contains several rules concerning processing, privileges, authentication, routing, etc.
Once routing is applied and the destination endpoint is determined, the policies for this destination
endpoint are applied. The context is maintained, so as to be applied to future packets in the same
flow. The following screen illustrates the flow through the Avaya SBCE to secure a SIP Trunk call.

“Trunk Server”

“ “Call S . w
ngé?gs;}m ch‘icy gfr‘;ifp 2:::: Trgrélé?(;:\:i’r = Policy Group 5
.‘ £
2 :
f ) F g )
D (¢
- “Call Server” 8 i “Trunk Server” . &
9 Call St ¢ ied " Trunk S =
Policy Group SaBC'FPII;:‘v . ;::Iling Policy Group r;gcu i:;i,r o E -
a
]
Avaya SBCE
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The End-Point Flows define certain parameters that pertain to the signaling and media portions of a
call, whether it originates from within the enterprise or outside of the enterprise.

To create the call flow toward the Service Provider SIP trunk, from the Device Specific Settings
menu, select End Point Flows (not shown), then the Server Flows tab. Click Add (not shown).

Name: SIP_Trunk_Flow_UDP.
Server Configuration: Service Provider UDP.

URI Group: *

Transport: *

Remote Subnet: *

Received Interface: Private_sig.

Signaling Interface: Public_sig.

Media Interface: Public_med.

Secondary Media Interface: None.

End Point Policy Group: Service Provider.
Routing Profile: Route_to IPO_TLS (Note that this is the reverse route of the flow).
Topology Hiding Profile: Service_Provider.
File Transfer Profile: None.

Signaling Manipulation Script: None.
Remote Brach Office: Any.

e Click Finish.

Flow Name [SIP_Trunk_Flow_UDP x|
Server Configuration [Service Provider UDP |
URI Group
Transport
Remote Subnet |* |
Received Interface
Signaling Interface
Media Interface
Secondary Media Interface
End Paint Policy Group [Service Provider v
Routing Profile [Route_to_IPO_TLS V|
Topology Hiding Profile
Signaling Manipulation Script |Nune v
Remote Branch Office
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To create the call flow toward IP Office, click Add (not shown).

e Name: IP_Office_Flow.
e Server Configuration: IP Office.
e URI Group: *
e Transport: *
e Remote Subnet: *
e Received Interface: Public_sig.
e Signaling Interface: Private_sig.
e Media Interface: Private_med.
e Secondary Media Interface: None.
e End Point Policy Group: IPO SRTP.
e Routing Profile: Route_to_SP_UDP (Note that this is the reverse route of the flow).
e Topology Hiding Profile: IP Office.
e File Transfer Profile: None.
e Signaling Manipulation Script: None.
e Remote Brach Office: Any.
e Click Finish.
Flow Name IP_Office_Flaw x|
Server Configuration [IP Office ~
URI Group
Transport
Remote Subnet [ |
Received Interface
Signaling Interface
Media Interface
Secondary Media Interface
End Point Policy Group [IPO SRTP V|
Routing Profile [Route_to_SP_UDP |
Topology Hiding Profile IP Office v
Signaling Manipulation Script [None v
Remote Branch Office
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The following screen capture shows the newly created End Point Flows.

Alarms 4 Incidents

Status

Logs ~

Diagnostics

Users Settings ~ Help ~ Log Out

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> PPM Services

> Domain Policies

» TLS Management

,
Network Management
Media Interface
Signaling Interface
Session Flows
> DMZ Services
TURN/STUN Service
SNMP
Syslog Management
Advanced Options
> Troubleshooting

Session Border Controller for Enterprise

AVAYA

End Point Flows: Avaya_SBCE

Devices

Avaya_SBCE

Subscriber Flows IJ Server Flows |

Add

Click here to add a row description.

r Server Configuration: IP Office

End
Signaling Point
Interface Policy

Group

URI Received

Group  Interface Routing Profile

Priority  Flow Name

||:| IP_Office_Flow ~ Public_sig Private_sig PO Clone Edit Delete

SRTP Route_to_SP_UDP | View

View Clone Edit Delete

r Server Configuration: Service Provider UDP

End
Signaling  Point
Interface  Paolicy

Group

URI Received

Group Interface Routing Profile

Priority ~ Flow Name

||:| SIP_Trunk_Flow_UDP  * Private_sig  Public_sig gfg‘jigzr Route_to_IPO_TLS| View Clone Edit Delete

7. Claro SIP Trunking Service Configuration

To use Claro SIP Trunk service, a customer must request the service from Claro using the
established sales processes. The process can be started by contacting Claro via the corporate web site
at: http://www.Claro.com/business/voice/sip-trunk.html and requesting information.

During the signup process, Claro and the customer will discuss details about the preferred method to
be used to connect the customer’s enterprise network to Claro’s network. Claro will provide their
SIP Proxy IP address, Direct Inward Dialed (DID) numbers to be assigned to the enterprise, etc. This
information is used to complete the Avaya IP Office and Avaya Session Border Controller for
Enterprise configuration discussed in the previous sections.

During the interoperability testing, a VPN connection was used to connect the simulated enterprise
site to Claro’s network via the public Internet. The connection could also be done without the use of
a VPN connection, by directly connecting the Avaya SBCE to a public facing SBC located in
Claro’s network. This is accomplished by assigning public IP addresses, capable of being reached
across the public internet, to the Avaya SBCE (interface B1) and to the Claro’s SBC.
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http://www.centurylink.com/business/voice/sip-trunk.html

8. Verification and Troubleshooting

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly. This section also provides a list of useful troubleshooting tips that can be
used to troubleshoot the solution.

8.1 Verification Steps

The following steps may be used to verify the configuration:
e Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
o Verify that users at the PSTN can end active calls to endpoints at the enterprise by hanging
up.
e Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

8.2 IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections. Launch the
application from Start - Programs - IP Office - System Status on the PC where Avaya IP
Office System Status is installed, log in with the proper credentials.

AVAyA IP Office System Status

Help Exit About

Online | offline

Logon

T VLT T G [ 192.168.128.167 -

Services Base TCP Port: il

User Name: userna.me123|

Password:

W Auto reconnect

[l Secure connection
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Select the SIP Line of interest from the left pane. On the Status tab in the right pane, verify that the
Current State is Idle for each channel (assuming no active calls at present time).

IP Office System Status

Status Utiization Summary Alarms

SIP Trunk Summary
Line Service State: In Service
Peer Domain Mame: sip:/f10.64, 101,243
Resolved Address: 10.64.101.243
Line Number: 17
Mumber of Administered Channels: 10
Number of Channels in Use: ]
Administered Compression: GF11Mu, G711 A, G729 A
Enable Faststart: off
Silence Suppression: Off
Media Stream: RTP
Layer 4 Protocal: LUDP
SIP Trunk Channel Licenses: 128 . %
SIP Trunk Channel Licenses in Use: ]
SIP Device Features: UPDATE {Incoming and Outgoing)
I Group  Call Ref Current State Time in State Remote Media Address ~ Codec Connection Type C or D Other Party on Cal
1 Idle 03:20:32
2 Idle 1day 02:57:21
3 Idle 1day 02:57:20
4 Idle 1day 07:18:496
5 Idle 1day 07:18:46
[ Idle 1day 07:18:46
7 Idle 1day 07:18:46
8 Idle 1day 07:18:46
E] Idle 1day 07:18:46
10 Idle 1day 07:18:46
Trace Trace Al ] [ Pause ] [ Ping ] Call Detzils Graceful Shutdown ] [ Force Out of Service ] [ Print... ] I Save As...

e Select the Alarms tab and verify that no alarms are active on the SIP Line.

AVAyA IP Office System Status

Help Snapshot LogOff Exit About

Status  Utilization Summary Alarms

Alarms for Line: 17 SIP voip.centurylink.com

Occurrences Error Description
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8.3 IP Office

Monitor

The IP Office Monitor application can be used to monitor and troubleshoot signaling messaging on
the SIP trunk. Launch the application from Start - Programs > IP Office - Monitor on the PC
where IP Office Manager was installed. Click the Select Unit icon on the taskbar and Select the IP

address of the IP

Office system under verification.

£)
File Edit “iew Filkers Status Help

. Avaya IP Office SysMonitor - [STOPPED]

=8| »lE[T| X[F =

&< | mm

N

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

ra

All Settings — [
T1 | YPN | WAN | SCH | Jade |
a4TM | Cal | DTE | EConf | FameRelsy | GOD | H322 | Intedace |
IS0OM ] Ke_l,l.fLamp] Direch:ur_l,l] tedia ] PP ] RZ ] Houting] Semvices S_I,Istem]
Events
¥ Sip [Verbows = ™ STUN [ SIP Dect
|
FPackets
[~ 5IP Reg/Opt Rx [~ SIF Misc Rx
[ SIP Reg/Opt Tx [ SIP Misc Tx
[~ SIPCallRx [~ Cm Motify Rx
[~ SIPCall T [~ Crn Motify Tx
v Sip Bx IP Filter [nnm.nnn.nnn.nnn)
W Sip Tx |
|
Default .a.u‘ Clear All ‘ Tab Clear.&ll‘ Tab semu| Corad
S s ‘ Lazd Fle ‘ Load Partial File| &l ‘

— o
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8.4 Avaya Session Border Controller for Enterprise

There are several links and menus located on the taskbar at the top of the screen of the web interface
that can provide useful diagnostic or troubleshooting information.

Alarms: Provides information about the health of the Avaya SBCE.

Alarms  Incidents

Status v

Users

Logs v

Diagnostics

Settings ~ Help v Log Out

Global Parameters

Domain Policies
TLS Management
Device Specific Settings

Session Border Controller for Enterprise

Dashboard System Management

Administration

Backup/Restore

Devices H Updates U SSL VPN U Licensing U Key Bundles I

AVAYA

Device Name B Version Status
Global Profiles P
PPM Services Avaya_SBCE :'5253'20’11’ Commissioned Reboot Shutdown Restart Application View Edit Uninstall

The following screen shows the Alarm Viewer page.

Devices

EMS

Avaya SBCE

Alarm Viewer

Alarms

AVAYA

M D Details State Time

No alarms found for this device.

| Clear Selected || Clearaul |

Device

Incidents: Provides detailed reports of anomalies, errors, policies violations, etc.

Alarms  Incidents

Status ~

Users

Logs v

Diagnostics

Settings v Help ~  Log Out

Global Parameters

Domain Policies
TLS Management
Device Specific Setlings

Session Border Controller for Enterprise

Dashboard System Management

Administration

Backup/Restore

Devices “ Updates U SSL VPN H Licensing “ Key Bundles I

AVAYA

Device Name m‘anagement Version Status
Global Profiles
PPM Services Avaya_SBCE ;"5253'20'11' Commissioned Reboot Shutdown Restart Application View Edit Uninstall
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The following screen shows the Incident Viewer page.

Incident Viewer AVAYA

Device [ Avaya_SBCE V| Category [Licensing ~| [ ClearFilters Refresh || Generate Report |

Displaying results 0 to 0 out of 0.

Date [up] Time [up] Category

No incidents found.

Diagnostics: This screen provides a variety of tools to test and troubleshoot the Avaya SBCE
network connectivity.

Alarms  Incidents  Statusv  Logs~  Diagnostics  Users Settings v Help v Log Out

Session Border Controller for Enterprise AVAYA
Dashboard System Management
Administration
Backup/Restore
System Management Devices |l Updates I { SSL VPN H Licensing H Key Bundles I

Global Parameters

Device Name B Version Status
Global Profiles P
PPM Services Avaya_SBCE :'5253'20’11’ Commissioned Reboot Shutdown Restart Application View Edit Uninstall

TLS Management

[
¥
[
> Domain Policies
[
[

Device Specific Settings

The following screen shows the Diagnostics page with the results of a ping test.

Pinging 192.168.128.167 X

Average ping from 10.64.101.244 [A1] to 192.168.128.167 is 66.293ms.
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Additionally, the Avaya SBCE contains an internal packet capture tool that allows the capture of
packets on any of its interfaces, saving them as pcap files. Navigate to Device Specific Settings =
Troubleshooting = Trace. Select the Packet Capture tab, set the desired configuration for the
trace and click Start Capture.

Alarms  Incidents  Status~  Logs~  Diagnostics  Users Settings v Help ~  Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Trace: Avaya_SBCE
Administration
Backup/Restore
Devices
System Management _ | Packet Capture | Sats I
Avaya_SBCE
Global Parameters Packet Capture Configuration
Global Profiles Status Ready
PPM Services
Domain Policies Interface
TLS Management Local Address [ann vl |
IP[:Porf]
4| Device Specific Settings
Remote Address ‘g
Network Management * =Port, IP, IP-Part
Media Interface Protacol
Signaling Interface
End Point Flows Maximum Number of Packets to Capture 10000
Session Flows Capture Filename
usinpg the name of an existing capture will overwrite it ‘Claro.pcap
DMZ Services
TURNSTUN Service
SNMP

Syslog Management
Advanced Options

4| Troubleshooting

Debugging
DoS Learning
Logs Collection
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Once the capture is stopped, click on the Captures tab and select the proper pcap file. Note that the
date and time is appended to the filename specified previously. The file can now be saved to the
local PC, where it can be opened with an application such as Wireshark.

Alarms  Incidents Status~ Logs~ Diagnostics Users Settings v Help v  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Trace: Avaya_SBCE
Administration

Backup/Restore

Devices
System Management _ Packet Capture | | Captures |

Avaya_SBCE

Global Parameters
Global Profiles

PPM Services
Domain Policies Claro_20180719141843.pcap 57,344

File Name File Size (bytes) Last Modified

July 19, 2018 2:19:05 PM T
EDT Delete

TLS Management

4| Device Specific Settings |

Network Management
Media Interface
Signaling Interface
End Point Flows
Session Flows

DMZ Services
TURN/STUN Service
SNMP
Syslog Management
Advanced Options

4 |Troubleshooting

Debugging

DoS Learning

Logs Collection
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9. Conclusion

These Application Notes describe the configuration steps necessary for configuring Session
Initiation Protocol (SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office
Release 11.0 and the Avaya Session Border Controller for Enterprise Release 7.2.2 to interoperate
with Claro SIP Trunking Service, as shown in Figure 1.

Claro SIP Trunking Service passed compliance testing with the observations/limitations outlined in
the scope of testing in Section 2.1 as well as under test results in Section 2.2.
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11. Appendix A: SigMa Scripts

Following is the Signaling Manipulation scripts that was used in the configuration of the Avaya
SBCE, Section 6.3.4. When adding these scripts as instructed in Sections 6.3.3 enter a name for the
script in the Title (e.g., Add_Privacy Header) and copy/paste the entire scripts shown below.

Title: Add_Privacy Header

within session "INVITE"
{
act on message where %DIRECTION="OUTBOUND" and
%ENTRY_POINT="POST_ROUTING"
{
/I fix anonymous
if (%W HEADERS["From"][1].URI.USER = "anonymous") then

{
if (exists(%HEADERS["Privacy"][1])) then

{
%do = "nothing";
}
else
{
%HEADERS["Privacy"][1] = "id";
}
¥
}
}
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are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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